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Sales Tools

Oracle Eloqua's Sales Tools extend Eloqua's functionality to support the sales effort, like

Oracle Eloqua supports the marketing effort. Engage helps you create consistent on-

brand emails and Profiler provides an at-a-glance summary of each contact's activities

over the last months.

Oracle Eloqua Sales Tools for Google Chrome is an extension which allows you to

leverage Profiler and Engage features in an easy to access pop-up in your Chrome

browser.

Oracle Eloqua Sales Tools for Microsoft Outlook is an add-in for Microsoft Outlook that

provides easy access to both Profiler and Engage through Outlook's email composer.

Learn more by watching these videos: https://www.youtube.com/playlist?list=PLw7GyH-

Hj8cPEFBlaiKsURlIiRB3SF_zd

https://www.youtube.com/playlist?list=PLw7GyH-Hj8cN-9g3FUVmr00GVGHClP-_T
https://www.youtube.com/playlist?list=PLw7GyH-Hj8cN-9g3FUVmr00GVGHClP-_T
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Configuring Eloqua contact views in Sales
Tools

A Contact view is an arrangement of contact fields that can be defined in Eloqua and then

used for specific use cases within both Sales Tools products – Profiler and Engage:

l Profiler – Customize the contact fields a sales user can see within the Details section of a

contact’s profile. You can provide one or more views that a user can access for a contact, based

on your needs. See Contact view usage in Oracle Eloqua Profiler

l Engage – In the compose window of Engage, if a sales user has the permission to create a

contact, you can select which set of contact fields (a contact view) a sales user should populate

when creating the contact. Views will respect field-level settings for whether or not the field is

required for a contact. See Contact view usage in Oracle Eloqua Engage

One or more views can be enabled for sales users. However, best practice is to only

enable a single view to provide a simple, streamlined user experience for the sales user.

Prerequisites to seeing contact views in Sales Tools

Configuring contact views for Sales Tools is a two-step process:

1. Create Views: The first step is to create a contact view to use within Sales Tools. If you haven’t

created any contact views, reference the Creating contact views topic in the Eloqua help center.

2. Enable access for select sales user security groups: After you have created your contact

view, you will need to ensure the view shows up in the appropriate Sales Tools product and to

the right users. You will need to grant access for the view to specific security groups. For more

information, see Editing contact views.

After completing this two-step configuration, you can now review the user experience in

the Sales Tools products to ensure the setup meets your requirements.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=CreatingContactViews
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=EditingContactViews
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Contact view usage in Oracle Eloqua Profiler

When viewing a contact's profile in Profiler, users can view different field information

about a contact under the Details tab by changing the contact view.

To change the contact view in Profiler:

1. Open a contact's profile in Profiler.

2. Open the Details tab.

3. Select a contact view from the View drop-down.

The Contact Details section will display different information based on the contact view you

select.
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Contact view usage in Oracle Eloqua Engage

When composing an email in Engage, sales users that have the permission to create

contacts will be required to populate a set of fields that marketing has defined in a view.

To change the contact view when creating a new contact in Engage:

1. Open Engage.

2. Click Compose then select a template.

3. In the To field, type in the new contact's email address and press Enter.

4. Double click on the email address.

The Create Contact dialog opens.
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5. The user will see the view you have set for them with the appropriate fields to populate.

ëNote: The best practice is to create one view that a sales user should use for creating

new contacts. If more than one view is available, the user will see a drop-down listing the

available views. While this is technically possible, it adds complexity for ongoing training

and may cause friction in the adoption process for the users within your Salesforce.



©2025 Oracle Corporation. All rights reserved 11 of 269

The Create Contact dialog will display different contact fields to fill out depending on the contact

view you select. Note that fields you have set as required will clearly display as required for the

sales user.
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Profiler

Profiler is one of Oracle Eloqua's Sales Tools. It presents valuable information about

contacts in an easily accessible and data-rich format that can be viewed on desktop

computers, tablets, and mobile devices.

With Profiler, you're able to view the contact details for a potential customer, their

activities, lead score, and so on. It is designed specifically for use with iOS and Android

devices, giving marketers and sales reps the option to access Oracle Eloqua's Profiler

functionality from their mobile devices when they are on-the-go.

See examples of Profiler's responsive design on desktop:

Learn more by watching this video

ëNote: Before you can access Profiler, an Eloqua administrator must install the app

in your Oracle Eloqua instance. Once installed, the customer administrator can

customize the options that Profiler provides. Learn more about installing and

configuring Profiler.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SalesTools
https://www.youtube.com/playlist?list=PLw7GyH-Hj8cNIagPdsRf2nk-tA00-0lMJ
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Installing Profiler

Before you can use Profiler a user with client administrator rights must install the app and

configure the settings for your Eloqua instance.

ZImportant: Because deleting or deactivating the installer user account will impact

installed apps, we recommend installing apps using a user account that is not tied

to a specific person. The user account must have customer administrator rights.

To install the Profiler app:

1. Follow the Profiler installation URL provided:

https://login.eloqua.com/?ReturnUrl=Apps/Cloud/Admin/Catalog/Add/512cc250-bf75-4b64-

98c2-9ce3858a18e1/D3-01-E2-AB-6C-23-36-17-7C-B1-44-49-89-11-D0-C3

2. Log in with your Eloqua credentials, if required.

3. Click Accept and Install to add the app to your Apps list.

4. Confirm your credentials and click Sign In.

https://login.eloqua.com/?ReturnUrl=Apps/Cloud/Admin/Catalog/Add/512cc250-bf75-4b64-98c2-9ce3858a18e1/D3-01-E2-AB-6C-23-36-17-7C-B1-44-49-89-11-D0-C3
https://login.eloqua.com/?ReturnUrl=Apps/Cloud/Admin/Catalog/Add/512cc250-bf75-4b64-98c2-9ce3858a18e1/D3-01-E2-AB-6C-23-36-17-7C-B1-44-49-89-11-D0-C3
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5. Configure Profiler:

Settings

a. Email alerts: Allow users to create email notifications for contact web visits.

b. Thumbnail previews: Allows users to see a thumbnail preview of marketing assets associated to a

contact's activity.
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c. Search: Allows users to search for contacts in Profiler by contact fields (name, email address, domain,

etc.). Otherwise, users can only search by email address.

d. Subscriptions: Allows users to view the email address of contacts that have globally unsubscribed.

Users cannot email these contacts and a visual indicator indicates the contact's global subscription

status. Otherwise, users cannot view the email address of such contacts.

e. External activity: Allows users to see external activities in Profiler. Choose the external activity assets

that should be visible to users.

Social Field Mappings

a. The Social Field Mapping section allows you to specify the social network account links available in

Profiler as part of the contact summary. Profiler will build the links to the social network site using the

mapped contact field. To link to social network sites, choose the contact field that should be used for

each social network.

Apps

a. View and search installed Profiler apps.
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App Access

a. Select the security groups which should have access to the Profiler app.

ëNote: Users must log out of Eloqua for Eloqua security group changes to take effect.

Allowed Domains

a. Identify which domains are allowed to host Sales Tools pages. For example, if you embed Sales

Tools in an iframe hosted by your CRM, add the domain of the page hosting the iframe to your

allowlist. You can allow a domain and its sub-domains using a wildcard (*).

To avoid broken iframes, add your CRMs to the Profiler allowlist and Engage allowlist, and update the

Sales Tools URLs you have embedded in an iframe to the new URLs. Here is a list of suggested

domains for the allowlist based on CRMs:

l Salesforce: *.force.com, *.salesforce.com, *.my.salesforce.com, *.lightning.force.com, and

*.visualforce.com

l Oracle CX Sales: *.oraclecloud.com

l Oracle CRM On Demand: *.crmondemand.com

l Microsoft Dynamics: *.dynamics.com

To learn more about embedding Profiler in different CRMs, see Profiler integration.

6. Click Accept or switch users.

The app is now installed and can be viewed in your Apps list (Settings > Apps, under

the Platform Extensions section). Select an app to view a description, modify the

SecurityGroups.htm
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=ReconfiguringProfiler
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=EngageReconfiguring
https://community.oracle.com/topliners/discussion/4476431/eloqua-product-notice-sales-tools-crm-embed-changes-nov-2020-feb-2021
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Apps
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configuration settings, reinstall, or uninstall it. You can also check its status and

dependencies.

You can change these configuration settings at any time. Learn more about reconfiguring

Profiler.

Configuring Profiler

You can manage how users can use Profiler. For example, manage the ability to create

email alerts, what external activity assets are available for viewing, and so on. You can

also manage who has access to Profiler apps that have been installed.

ZImportant: The configuration process must be done by a user with customer

admin rights.

To configure Profiler:

1. Log in to Oracle Eloqua.

2. Click Settings .

3. Click Apps in the Platform Extensions section.

4. Select the Profiler app.

5. Click Configure .

6. Reconfigure Profiler using the following tabs as needed.
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Settings

a. Email alerts: Allow users to create email notifications for contact web visits.

b. Thumbnail previews: Allows users to see a thumbnail preview of marketing assets associated to a

contact's activity.

c. Search: Allows users to search for contacts in Profiler by contact fields (name, email address, domain,

etc.). Otherwise, users can only search by email address.

d. Subscriptions: Allows users to view the email address of contacts that have globally unsubscribed.

Users cannot email these contacts and a visual indicator indicates the contact's global subscription

status. Otherwise, users cannot view the email address of such contacts.

e. External activity: Allows users to see external activities in Profiler. Choose the external activity assets

that should be visible to users.

Social Field Mappings

a. The Social Field Mapping section allows you to specify the social network account links available in

Profiler as part of the contact summary. Profiler will build the links to the social network site using the

mapped contact field. To link to social network sites, choose the contact field that should be used for

each social network.

Apps

a. View and search installed Profiler apps.
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App Access

a. Select the security groups which should have access to the Profiler app.

ëNote: Users must log out of Eloqua for Eloqua security group changes to take effect.

Allowed Domains

a. Identify which domains are allowed to host Sales Tools pages. For example, if you embed Sales

Tools in an iframe hosted by your CRM, add the domain of the page hosting the iframe to your

allowlist. You can allow a domain and its sub-domains using a wildcard (*).

To avoid broken iframes, add your CRMs to the Profiler allowlist and Engage allowlist, and update the

Sales Tools URLs you have embedded in an iframe to the new URLs. Here is a list of suggested

domains for the allowlist based on CRMs:

l Salesforce: *.force.com, *.salesforce.com, *.my.salesforce.com, *.lightning.force.com, and

*.visualforce.com

l Oracle CX Sales: *.oraclecloud.com

l Oracle CRM On Demand: *.crmondemand.com

l Microsoft Dynamics: *.dynamics.com

To learn more about embedding Profiler in different CRMs, see Profiler integration.

7. Click Save to save your settings.

Your configuration settings have been updated. You can modify them at any time.

SecurityGroups.htm
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=ReconfiguringProfiler
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=EngageReconfiguring
https://community.oracle.com/topliners/discussion/4476431/eloqua-product-notice-sales-tools-crm-embed-changes-nov-2020-feb-2021
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Accessing Profiler

Work with your sales organization to determine the best method for accessing Oracle

Profiler. You can use any of the following methods:

l Integrate Profiler with your CRM

This would allow sales users to access Profiler directly from the CRM. You can embed Profiler

as a tab, link to it as a button, etc. Learn more.

l Direct link

This is a customizable link you can use to launch Profiler directly.

l Use the Oracle Eloqua Sales Tools for Microsoft Outlook add-in

This is an add-in that your users can install on their own or your IT department can deploy to an

entire organization. See Oracle Eloqua Sales Tools for Microsoft Outlook.

l Oracle Eloqua Sales Tools for Google Chrome

The Google Chrome extension allows sales representatives to access Profiler from their

Google Chrome browser. For example, while browsing prospect websites, the sales rep can

open the extension to review Eloqua contacts at that company. Reps can also access Engage

directly from the extension. Learn more.

ëNote: Before you can access Profiler, an Eloqua administrator must install the app

in your Oracle Eloqua instance. Once installed, the customer administrator can

customize the options that Profiler provides. Learn more about installing and

configuring Profiler.

Profiler URLs

To access Profiler , you can use one of the following types of URLs: 

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SalesToolsMicrosoftOutlook
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l A simplified login URL that will handle all login flows based on the user logging in and your

Oracle Eloqua configuration. Using this URL, if you have SSO configured for the instance and

user, then the user will be redirected to your default identity provider login screens. If you don't

have SSO, the user will be prompted for their user name and password. Learn more.

l A legacy login URL that is specific to the desired login flow and security model at your

organization. There is a separate login URL for auto-login, SAML login, or CVP login. Auto-login

and SAML are options that support Single Sign-On (SSO). Salesforce IDP is an option for

Salesforce SSO logins. Direct login is for logging in directly through Eloqua. Learn more.

Simplified login URL

To access the Profileremail composer using the simplified login URL:

https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/salesTools/profiler

If you are embedding Profiler pages into an iframe, use the following URL. Learn more.

https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler

The following table describes the supported URL parameters you can use to further

customize the login experience. In addition, you can also add additional Profiler URL

parameters to customize the compose experience. Learn more about Profiler

URL parameters.

Parameter Description
SiteName=
{company
Name}

Optional

Your instance company name. When provided, users are not prompted to

provide a company name. If the user has an existing session, they will then
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Parameter Description

be logged in automatically.

Example:

https://login.eloqua.com/siteLogin?SiteName=ExampleSi

teName

ReturnUrl=
{Url}

Optional

The Oracle Eloqua URL to redirect to after logging in.

You must provide the SiteName parameter if you want to use this parameter.

Example:

Redirect to the Engage email compose page:

https://login.eloqua.com/siteLogin?SiteName=ExampleSi

teName&ReturnUrl=/apps/salesTools/engage/compose

Checkfram
e={true or
false}

Optional

Checks if the login page is being accessed from within an iframe and create

a popup window if it is.

l true checks for the frame.

l false does not check for the frame. If the result is a displayable page that cannot

be viewed in an iframe, then the user will get a block from their browser. Use only

if it can be guaranteed the current user is already authenticated with the default

SSO used by Oracle Eloqua to skip the popup.

Example:
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Parameter Description

Checkframe while logging into Engage:

https://login.eloqua.com/siteLogin?SiteName=ExampleSi

teName&CheckFrame=true&ReturnUrl=/apps/salesTools/eng

age/compose

UseDefault
SSO={true
or false}

Optional

Specifies whether or not to use the default identity provider configured for

your instance. Use this parameter if you have multiple identity providers and

want to ensure the default identity provider is used.

l true to use the default SSO

l false to prompt the user to choose the identity provider

Example:

Checkframe while logging into Engage:

https://login.eloqua.com/siteLogin?UseDefaultSSO=true

Idp=
{IdentityPr
oviderId}

Optional

The ID for the identity provider you want to use. Use this parameter if you

have multiple identity providers configured for your Oracle Eloqua instance

and you want to use a non-default identity provider. You can retrieve the

identity provider ID from the SSO identity provider screens.

You must provide the SiteName parameter if you want to use this parameter.

Example:
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Parameter Description

https://login.eloqua.com/siteLogin?SiteName=ExampleSi

teName&Idp=69627DAC73E04DE79CDFC90D132B65EA

Username
=
{username
}&Passwor
d=
{encrypted
Password}

The user name and encrypted password. The password parameter is

encrypted. To retrieve the encrypted version of the user password, you must

open a Service Request with Oracle Support.

You must provide the SiteName parameter if you want to use the user name

and password parameters.

Legacy login URLs

The following lists the legacy login URLs to access to Profiler based on the desired login

methods. These URLs continue to be supported. The URL you use depends on the

security model implemented at your organization. Auto-login and SAML are options that

support Single Sign-On (SSO). Salesforce IDP is an option for Salesforce SSO logins.

Direct login is for logging in directly through Eloqua.

The following lists the URLs to access the Profiler search page based on these login

methods:

l Direct: https://login.eloqua.com/apps/salesTools/profiler

l Embedded: https://login.eloqua.com/apps/embed/salesTools/profiler

l Autologin: https://login.eloqua.com/autoLogin?LoginPrefix={Login_

Prefix}&Url=/apps/salesTools/profiler
l Embedded: https://login.eloqua.com/autoLogin?LoginPrefix={Login_

Prefix}&Url=/apps/embed/salesTools/profiler

l SAML: https://login.eloqua.com/auth/saml2/autologin?LoginPrefix={Login_

Prefix}&ReturnUrl=/apps/salesTools/profiler
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l Embedded: https://login.eloqua.com/auth/saml2/autologin?LoginPrefix={Login_

Prefix}&ReturnUrl=/apps/embed/salesTools/profiler

l SFDC IDP: https://{podURL}/sso/sfdc/v1/svp.aspx?LP={Login_

Prefix}&RU=/apps/salesTools/profiler
l Embedded: https://{podURL}/sso/sfdc/v1/svp.aspx?LP={Login_

Prefix}&RU=/apps/embed/salesTools/profiler

Replace {podURL} with the URL in your browser after you have logged in successfully to

Eloqua (for example, secure.p01.eloqua.com). Click here for additional information about how

to determine your pod.

LoginPrefix values are a unique four-character code for your Eloqua instance. To add this

parameter to your URL, enter LoginPrefix={prefix} where {prefix} is replaced with the four-

character company name. You can obtain your company's login prefix in Eloqua by

navigating to Settings > Display Preferences > Company Defaults.

¤Tip: If you are using Microsoft Edge or Sales Tools for Microsoft Outlook to access

the Oracle Eloqua sign in page in an iframe, an addition should be made to trusted

sites. Add https://*.eloqua.com and the URL of the site where the login page

(Oracle Eloqua and/or Sales Tools) is being iframed. The browser must be closed

fully and restarted before the change is recognized. For additional information, see

this Topliners post about Oracle Eloqua login enhancements.

Embedding Profiler pages

You can embed Profiler pages into an iframe, allowing your users to access Profiler

directly from other apps at your organization. For example, embed Profiler directly into

your CRM.

To embed Profiler into an iframe:

https://community.oracle.com/docs/DOC-897330
https://community.oracle.com/docs/DOC-1020186
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1. Update the Profiler app with an allowlist of domains that will host Profiler pages. Learn more.

2. Adjust the URLs listed above to include /embed/ in the URL: 

/apps/embed/salesTools/profiler.

Learn more about Profiler integration.

Profiler URL parameters

The URLs above open Profiler to the search page. You can also directly access a

contact's record in Profiler using their email address. Simply add the following to the

URLs above, and insert the contact's email address where needed:

?emailAddress={emailAddress}

Your CRM integration can provide the email address to this URL. Learn more about

Profiler integration.

Apps for Profiler

Apps that are available for Oracle Eloqua Profiler are built on Oracle CX Apps, which is

the extension framework that partners and customers can use to build apps that are

available for multiple applications within Oracle CX Marketing. For more information on

Oracle CX Apps, visit the Oracle CX Marketing App Manager Help Center.

In this topic, you'll learn about:

l Installing apps for Profiler

l Managing Profiler app extensions

l Restricting access to a Profiler app using Oracle Eloqua Security Groups

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCIA/index.htm
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Installing apps for Profiler

Apps available for Profiler can be found in the Oracle Cloud Marketplace

(https://cloudmarketplace.oracle.com/marketplace/en_US/homePage.jspx). Once the

app is installed in Profiler, you'll be able to manage and configure it from within Oracle

Eloqua.

ZImportant: The configuration process must be done by a user with client

administrator rights.

Installation is a straight forward guided experience that will generally follow these

steps:

1. Start in the Oracle Cloud Marketplace (https://cloudmarketplace.oracle.com/marketplace/en_

US/homePage.jspx) and search for the app you want to install.

2. Click on the app listing, then click the Get App button.

3. You will be prompted where you want to install the app, if it was built to be used with multiple

Oracle CX Marketing products i.e. Eloqua Sales Tools, Responsys or Maxymizer. In this case

you will be installing into one of the Sales Tools products. Pick the product where you want to

install the app.

4. Log in with your Eloqua credentials, if required.

5. Click Confirm to confirm the installation of the app into Oracle Eloqua Profiler.

Although there may be slight variances in the flow, these are generally the steps you will

experience when installing an app. After you’ve installed the app, you can review its

configuration and control its usage based on your individual needs.

https://cloudmarketplace.oracle.com/marketplace/en_US/homePage.jspx
https://cloudmarketplace.oracle.com/marketplace/en_US/homePage.jspx
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Managing Profiler app extensions

Apps installed for Profiler are accessible from within Profiler’s app configuration. This is a

bit different from other apps in Oracle Eloqua because apps installed for Profiler do not

display in the main AppCloud Catalog. You must go into the settings for Profiler itself to

locate the apps that you’ve installed just for Profiler.

To manage Profiler app extensions from within Oracle Eloqua:

1. Click Settings in the global header.

2. Click Apps in the Platform Extensions section.

3. Find and open the Profiler app.

4. Click Configure .

qWarning: Selecting the Reinstall option for an app will force you to go through the

entire installation process again. The app will be unavailable for all users during the

reinstall.

5. Click the Apps tab.

6. Click on the app to open the configuration options for that app.

7. You can perform the following actions:

l Get Dependencies : View any assets that are using the app's services and would be affected if the

app was uninstalled.
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l Configure : Allows Marketing Administrators to set up the extension directly from Oracle Eloqua.

l Uninstall : Uninstall and remove the app from your Profiler instance.

l Services: View the kinds of services you currently have under the app.

Restricting access to a Profiler app using Oracle Eloqua Security Groups

There are certain circumstances where you may want to restrict who can access an app

installed in Profiler. A couple of use cases to consider:

l You are running an app pilot with a select set of trusted power users within the sales team.

l The app is provided by a third party and requires a paid license that is not available to all sales

users i.e. an account based application where licenses are only available for strategic account

managers and not inside sales.

l The App Access section within Profiler’s global settings will allow you to control who has access

to an app you’ve installed.

1. Click Configure in the Profiler page of the AppCloud Catalog.

2. Open the App Access tab.

3. Check the box beside Allow access only to these to security group(s).

ëNote: When an app is installed, it is available to all users by default. If the box beside

Allow access to security groups is checked but no security groups are selected, then all

security groups are granted access.

4. From the Select a security group drop-down, select the Oracle Eloqua security groups

containing users that should be granted access to the Profiler app.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCIA/Developers/salestools/tasks/creating-profiler-services.htm
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ZImportant: The listed security groups have been configured in Eloqua. Additionally,
modifying access settings will immediately change access for users, including deletion of

user settings.

5. Click Save.

Uninstalling apps within Profiler

Apps installed for Profiler can be uninstalled from within Profiler’s app configuration. This

is a bit different from other apps in Oracle Eloqua because apps installed for Profiler do

not display in the main AppCloud Catalog. You must go into the settings for Profiler itself

to locate the apps that you’ve installed just for Profiler.

To delete Profiler app extensions from within Oracle Eloqua:

1. Click Settings in the global header.

2. Click Apps in the Platform Extensions section.

3. Find and open the Profiler app.

4. Click Configure .

5. Click the Apps tab.

6. Click on the app to open the configuration options for that app.

7. Click Uninstall to uninstall and remove the app from your Profiler instance.
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Searching for contacts in Profiler

Profiler allows you to view contact information and Oracle Eloqua marketing activities

using a convenient and device friendly interface.

You can search for contacts by:

l First name

l Last name

l Email address

l Title

After you have search results, you can further filter the results by:

l Title

l Account

l City

l Email domain

To search for a contact in Profiler:
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1. Select the icon in the upper right-hand corner of the Profiler screen.

ëNote: You can also use the Search Contacts field that appears on the search page
when you open the app.

2. Type your search words in the Search bar. You can search by a contact's First Name, Last

Name, Email Address, or Title . The search is not case-sensitive. The results display a list of all

contacts who have a matching contact field that starts with your search criteria.

-Example: A search for Alex displays users such as Alex, Alexandra, and Alexander.

3. (Optional) Filter your search results by clicking Filter . The filter panel displays on the right.

l Filter by title, account, city, or domain, and click Apply. Filtering shows users that match all of your

filtering criteria (using an AND operator).

l Click the X next to a filter to remove it. To remove all filters, click Clear.

The example below shows filtering by domain of example.com and title of CEO. The results display all

users who match both of these criteria. Users who have CEO as the title, but a different domain will

not appear.
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4. Select the name of the correct contact from the list. Their contact record opens displaying their

details and activities. Learn more about the information provided in Profiler.

After your first visit to Profiler, a recently-viewed contacts list is displayed on the

homepage. This convenient list makes it easier to locate the contacts that you may be

dealing with on a regular basis, or with whom you are attempting to establish a

connection. From this recently viewed list you can select the contact's name and you are

taken directly to their contact record.

Viewing a contact in Profiler

When you open a contact record in Profiler, you can view details about the contact as well

as valuable information about the contact's interactions with your organization's

marketing materials and website.
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Good to know

Note the following:

l Profiler shows marketing related activity, such as email opens, clicks, form submissions, and so

on. The following lists the activities available in Profiler:

l Emails Sends: The number of emails sent to this contact.

l Emails Opens: The number of times emails were opened by the contact.

l Emails Clicks: The number of times that links in an email were clicked.

l Web Page Visits: The number of visits to tracked web pages.

l Form Submissions: The number of forms that were submitted by the contact.

l External Activities: The number of non-Eloqua (external) activities, such as attending a webinar,

trade show, and so on. Your administrator decides what external activities are available in Profiler.

l If you see activities repeated within minutes of each other, this could be the result of anti-virus

software scanning email links and images.

l Email thumbnails provide a view of the email as it was sent to the contact. You can use the

preview link to view the full email. Since content in an email can be dynamic and personalized,

the preview of the email may be different than the thumbnail.
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l An email preview link is available for 120 days after the send date.

l By default, you can view 1 year of activities for the contact. You can view older activities by

using the date filter on the Activities tab. For more details, see the Activities tab details below.

Contact details

Use the left panel to learn about the contact and how to reach them. Profiler provides you

with a number of ways of reach out to the contact.

l
Call the contact. If you are using your mobile device, you click to call the contact.

l
Reach out to the contact via email. Clicking the email address opens a new message in

Engage or your default email client.
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l Locate the contact using Google Maps. If there is an address for the contact, use this

feature to map to the contact's location.

l Reach out to the contact via LinkedIn. Clicking this icon opens the contact's LinkedIn

profile. Your administrator manages whether this and other social links are available. Learn

more about enabling these fields.

ëNote: Bounced back or unsubscribed. This icon indicates that you cannot

send a message to this contact, because the email address bounced back or the

contact is globally unsubscribed.

Before reaching out to a contact, arm yourself with information about the contact's

interaction with your organization by reviewing the details on the tabs in Profiler.

To review more details about the contact from the Oracle Eloqua contact record, open the

Details tab.

Lead score

A lead score is displayed for each contact in Profiler. This value is based on the lead

scoring models configured for Oracle Eloqua. Your administrator manages which models

are available to you. Learn more about lead scoring and changing the lead score model.

To change the lead score model displayed, click the lead score and choose from the

models available to you. After you make a choice, Profiler displays this model for all

contacts.



©2025 Oracle Corporation. All rights reserved 37 of 269

Summary tab

This tab presents the contact's activities in the following ways:

l Activities: This chart shows all the contact's activities within a specific date range. You can use

the calendar icon in the upper right-hand corner of the graph to change the date range, select

30 days, 6 months, or 1 year as needed. By default, all activity types are shown, tap or click the

activity type label below the graph to hide the corresponding data. To view the full activity

details for each bar on the graph, simply click an individual bar and the Activities tab opens

displaying the included activities in detail.
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l Latest Activities: This section shows the contact's activities from the last year. Expand the

activity to view more details about the activity, such as a preview of the email or web page. This

can give you a good idea about the contact's interests.

l Activity Breakdown: This section provides a breakdown of the contact's activities over the last

year, these are the same categories that are represented in the activities chart. The activities

are grouped based on type. Click or tap any activity type to view more details in the Activities

tab.

Activities tab

This tab shows you all of the contact's activities by date and time. You can expand an

activity to view more details about it, such as a thumbnail view of an email or web page, or

links that were clicked. Emails can also be previewed fully for up to 120 days after the

send date.

You can search for activities on or before a specific date. Click Filter and

choose a date. This returns activities on or before this date up to the last 25 months of

activities.
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Details tab

This tab provides you with more information about the contact. The fields that you can

see depend on the contact views that your administrator has made available to you. To

change the contact view, use the View list. Learn more about contact views in Profiler.

If messages to this contact have bounced back or the contact is globally unsubscribed,

the following icon is displayed next to the email address. These contacts can no longer be

reached by email.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=ContactViewsSalesTools
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About contact engagement fields

ëNote: Important: Effective June 12, 2025, Oracle Eloqua's Advanced Intelligence

(AI) features are available for all customers. To enable Eloqua's classic and

Generative AI (Gen AI) functionality, open a service request with Oracle Support.

Please review our product notice for more information.

If your organization has the Eloqua Advanced Intelligence Cloud Service, use the fields to

understand additional engagement information about the contact.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/Help/AdvancedIntelligence/AdvancedIntelligenceOverview.htm
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/Help/AdvancedIntelligence/AdvancedIntelligenceOverview.htm
https://support.oracle.com/
https://community.oracle.com/customerconnect/discussion/881211
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Email engagement

Using email send and open data, this rates the contact's email engagement on a scale of

Low to High.

l Low - Based on email sends and opens, this contact has poor levels of engagement. Consider

a highly personalized message or another way of reaching this contact.

l Medium - Based on email sends and opens, this contact's engagement is declining. Consider a

personalized message to try to help with engagement.

l High - Based on email sends and opens, this contact has ideal engagement.

l Uncategorized - Based on email sends and opens, there just isn't enough information to

categorize the engagement for this contact.

If no score available, there is no email engagement level for this contact yet.
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Account engagement

For contacts that are linked to an account in Oracle Eloqua, this score rates the overall

account activity. The scoring takes into consideration email opens, clickthroughs and

form submissions. The higher the score, the more engaged the account. To find other

contacts at this account, use the Profiler search feature to search by Account name.

Learn more about searching for contacts in Profiler.

Adjusting the lead score model displayed in Profiler

A lead score is displayed for each contact in Profiler. This value is based on the lead

scoring models configured in your Oracle Eloqua instance. Your administrator manages

which models are available to you. Learn more about lead scoring.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=LeadScoring
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How Oracle Eloqua evaluates leads

Oracle Eloqua uses two sets of criteria to evaluate a

lead:

l Profile criteria: This is explicit data about the lead,

such as title, industry, or company revenues. This type

of demographic data helps identify who the prospect is

and the prospect's fit. Based on the profile criteria, the

lead is given a profile score of A, B, C, or D.
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l Engagement criteria: This is implicit data, such as visits to your website and responsiveness to

promotions. This type of data helps determine a lead's online behavior and can indicate how

interested the lead is. Based on the engagement criteria, the lead is given an engagement

score of 1, 2, 3, or 4.

Once Oracle Eloqua evaluates a lead against the profile and engagement criteria, it

combines the profile score and the engagement score and assigns the lead a lead score.

A1 is the most qualified lead and a D4 is the least qualified.

To change the lead scoring model displayed in Profiler:

1. With a contact profile open, click the lead score icon to the right of the contact's name. A list

opens displaying the available lead scoring models.

2. Select a new lead scoring model from the list. The new model is applied to the record and the

lead score icon is updated to reflect the change.
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ZImportant: When you change the lead scoring model for a contact, the selected

model is saved as your default model. All subsequent profiles that you view use the

selected lead scoring model.

Setting up activity notifications

The Profiler alerts allow you to set up alerts that will inform you each time a contact, or

anyone from the same domain, visits your website. As a Profiler user, you can set up

alerts when you view a contact. The alerts provide near real-time notifications whenever

a contact has visited your website.

ëNote: Profiler alerts must be enabled by your administrator. Learn more about

configuring the app.

To set up alerts in Profiler:

1. Open the profile for the contact for whom you wish to set up notifications.

2. Click the +Alert button below the contact's name. The Setup Alerts dialog opens.
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3. Select or clear the check boxes to specify in which cases you want to be notified.

4. Click Save. The dialog closes and your web alert preferences are saved for this contact. You

will be sent a notification email informing you of the contact's activities, according to the settings

you configured. When you receive a notification, click This Contact's Activity in the notification

email to open Profiler and view more details about the contact.

To find and remove alerts:

1. From the Sales Tools menu, go to Settings > Profiler > Email Alerts.

2. Open the profile for the contact for whom you wish to set up notifications.

3. Click the Alert button below the contact's name. The Setup Alerts dialog opens. The button

shows + to create a new one for the contact, or checkmark when you have one setup for the

contact.

4. Click View all Alerts. You will be redirected to the page where you can see Settings
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> Profiler > Email Alerts.

Viewing email alerts

Using Engageand Profiler, you can view a list of the email alerts you are subscribed to.

ëNote: Email alerts are displayed if you have a Profiler license.

To view email alerts:

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Engage
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Profiler
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1. Click Settings .
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2. Select the Email Alerts tab.
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Your existing email alerts are displayed. You can remove any email alerts you no longer

want to receive by clicking X.

Profiler integration

Profiler can be embedded in several customer relationship management (CRM) systems,

including Oracle Sales (formerly Oracle Sales Cloud), CRM onDemand, and Salesforce.

This integration makes it easier and more convenient for you to access the sales tool

from within your chosen system.

ëNote: If you already have an older version of Profiler embedded in a CRM, you

must replace the login URL.

Embedding Profiler as a subtab in Oracle Sales

ZImportant: Oracle Sales was formerly known as Oracle Sales Cloud. All instances

of Oracle Sales Cloud have been changed to Oracle Sales across the app user

interface.

To enrich the user experience when working in Oracle Sales, you can embed a Profiler

subtab into standard objects, such as Contacts and Sales Leads. This way, you can view

the contact details for a potential client, their activities, lead score, and so on without

needing to leave that Contact or Sales Lead object.
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Prerequisites:

l In Oracle Eloqua, build an allowlist of the domains that will be hosting embedded Profiler pages.

Learn how to configure Profiler.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more. The steps below

assume you are using the simplified login URL.

There are five steps to creating a Profiler subtab in Oracle Sales:

1. Creating a sandbox

2. Creating mashup content

3. Adding the mashup content to a standard object in Oracle Sales

4. Publishing your sandbox
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Step 1: Creating a sandbox

To create a sandbox:

1. Log in to Oracle Sales with your Administrator credentials.

2. Click Navigator at the top of the page, and under Configuration click Sandboxes.

3. Click Create Sandbox.

4. Ensure Application Composer is checked as Active, give your sandbox a name, and ensure

that Publishable is set to Yes.

5. Click Create and Enter.

You'll be redirected to the Available Sandboxes page.

Step 2: Creating mashup content

To create mashup content:
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1. At the top of the page, click Tools > Application Composer.

2. In the Overview section, click Mashup Content > Register Web Application. Alternatively, you

can click Mashup Content in the left-side panel under Common Setup.

3. Configure the following options:

l Give your web application a name. For example, Eloqua Profiler.

l Select Groovy expression.

4. Click Save and Close.
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Step 3: Adding the mashup content to a standard object

To add the mashup content to a Contact or Sales Lead object:

1. Still in the Application Composer, navigate to the left-side panel under Objects, expand

Standard Objects, then expand the object, either Sales Lead or Contact, that you want to add

the subtab to.

In our example, we'll be using the the Sales Lead object.
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2. Click Pages.

3. In the Application Pages tab, scroll down to the Details Page Layouts section, and click Default

Custom Layout.

ëNote: If you do not see the Default Custom Layout you can add it by duplicating an

existing layout. For example, duplicate the Standard layout, then edit the duplicate

layout.
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4. Scroll down and click Add .

5. Select Mashup Content, then click Next.

6. Select your Mashup Content from the Web Applications list, then click Insert.

7. Configure the following options:

l Give your subtab a name. In this case, you would give it a name related to Profiler. For example, you

could name the subtab Eloqua Profiler.

l (Optional) Click Change Icon to change your subtab's Display Icon.

8. In the Edit Script area, insert the following script:

if (PrimaryContactEmailAddress != null) {

return "https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddress=" +

PrimaryContactEmailAddress;

}

else {

return "https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler";
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}

¤Tip: If you're adding Profiler to the Contacts object, replace
PrimaryContactEmailAddress in the above code samples with

PrimaryEmailAddress. Since in this topic we're adding Profiler to the Sales Leads

object, we'll keep PrimaryContactEmailAddress in our code.

9. (Optional) Click Next. The Next option only appears if there are other details page layouts

available to add the subtab to.

10. Click Save and Close.

11. Done.

Step 5: Publishing your sandbox

1. Click Sandboxes, then click on your sandbox's name.

2. Click Publish.

After following these steps for Profiler, you can now view the subtab when you navigate to the

standard object's page. For example, since in this topic we created a subtab for the Sales Lead

object, we'll navigate to Navigator > Leads under Sales. Once you open a lead, you see the

Profiler subtab.
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Troubleshooting

l For Firefox users, if you’re using Autologin or SAML access methods, and you cannot progress

past the Oracle Eloqua authenticate now login screen, you may have to disable Firefox

enhance tracking protection. To do this, in Firefox, navigate to Options in the Firefox browser >

Privacy & Security > Enhanced Tracking Protection > select Custom > uncheck the box for

Cookies.

l If you see a content security policy directive message in the iframe, check that your Profiler

allowlist includes the required URLs for embedding in Oracle Sales. Make sure to also confirm

that the URL you are using is correct.

l If you have several IDPs setup with your SSO configuration, adjust the URL to use the specific

IDP you want. Otherwise, the default IDP will be used.
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Here is an example URL with the IDP parameter:

https://login.eloqua.com/siteLogin?SiteName=ExampleSiteName&Idp=696

27DAC73E04DE79CDFC90D132B65EA&ReturnUrl=/apps/embed/salesTools/prof

iler

Add Profiler to Oracle Sales Redwood User Experience

To add Oracle Eloqua Profiler in Oracle Sales Redwood User Experience, you can create

custom smart actions that navigate users to Eloqua Profiler.

There are three steps to launching Profiler in Oracle Sales Redwood User Experience:

1. Create a sandbox

2. Create a smart action

3. Publish a sandbox

Step 1: Create a Sandbox

1. Log in to Oracle Sales with your Administrator credentials.

2. Click Navigator at the top of the page, and under Configuration click Sandboxes.

3. Click Create Sandbox.

4. Ensure Application Composer is checked as Active, give your sandbox a name, and ensure

that Publishable is set to Yes.

5. Click Create and Enter.

You'll be redirected to the Available Sandboxes page.
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Step 2: Create a smart action

1. In Application Composer, click Smart Actions, available under Common Setup.

2. On the Smart Actions page, click Create. Application Composer displays the Create Smart

Action guided process in a new browser tab.

3. On the Kind of Action page:

a. Click UI-based action.

b. Click Continue.

4. On the Basic Details page:

a. In the Name field, enter a display name: Eloqua Profiler for the action.

b. In the Object field, select the Contact object for which you're creating the action. If you are embedding

for Leads, then select the Sales Lead. object

c. In the Action ID field, accept the automatically generated value or enter a unique value. This value

must be unique across all smart actions.

d. Click Continue.

5. On the Availability page:

a. In the Application field, select the Sales application where the action will display.

b. In the UI Availability field, select the List Page where the action will display in addition to the Action

Bar.

c. Optional - In the Role Filter field, optionally select the custom roles that can view the action. (If you

don't select a role, then the action will be available to all roles). For details see Create UI-Based Smart

Actions.

d. Optional - In the Condition region, optionally set conditions for the action to appear, such as only if a

certain field's value is set to a particular value. For example, show a smart action only if a lead's status

is Hot. For details see Create UI-Based Smart Actions.

6. On the Action Type Page:

https://docs.oracle.com/en/cloud/saas/applications-common/25a/oacex/create-ui-based-smart-actions.html
https://docs.oracle.com/en/cloud/saas/applications-common/25a/oacex/create-ui-based-smart-actions.html
https://docs.oracle.com/en/cloud/saas/applications-common/25a/oacex/create-ui-based-smart-actions.html
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a. In the Type field, specify the type of action, Navigate to URL.

b. In the URL field, insert the following URL:

https://login.eloqua.com/siteLogin?SiteName=

{EloquaCompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddress=${EmailAddres

s}.

c. If you are adding Eloqua Profiler to Contacts:

In the Value column for EmailAddress in the Field Mapping section, select Email (EmailAddress).

d. If you are adding Eloqua Profiler to Sales Leads:

In the Value column for EmailAddress in the Field Mapping section, select ContactEmail

(PrimaryContactEmailAddress).

e. In the Browser Window Target field, specify New tab.

7. On the Action Details page, leave it blank and click Continue.

8. On the Confirmation Message page, leave it blank and click Continue.

9. On the Review and Submit page, review the action's configuration and click Submit when

ready.

Step 3: Publish a Sandbox

1. Click Sandboxes, then click on your sandbox's name.

2. Click Publish.

After following these steps for Profiler, you will now be able to see Profiler from object list. For

example, if you we created a Smart Action for the Sales Lead object, then you will be able to

see Profiler for a Sales Lead from the action menu when a specific lead is selected.

After Completion, you should find the smart Action available for selection.
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Additionally the Smart Actions would be available to launch from a contact record.

Embedding Profiler into Oracle B2C Service

With Profiler, you're able to view the contact details for a potential customer, their

activities, lead score, and so on. By embedding Profiler into your Oracle B2C Service

workspace, you can get activity and lead score context for a customer or prospect—

before, while, or after you speak with them. In this way, Profiler can assist in preparing

yourself for customer communications.

Prerequisites:

l In Oracle Eloqua, build an allowlist of the domains that will be hosting embedded Profiler pages.

Learn how to configure Profiler.
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l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more. The steps below

assume you are using the simplified login URL.

To embed Profiler into Oracle B2C Service:

1. Log in to your B2C Service service console with your Administrator credentials.

2. Click Navigation > Configuration.

3. Click Application Appearance then double-click Workspaces / Workflows.

4. Create a new workspace or open an existing one.

¤Tip: Ensure that the workspace you create or select has a relationship with contacts, for
example, a contact workspace or incident workspace.

5. (Optional) Right-click on a tab, and click Add Tab After or Add Tab Before.
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6. (Optional) Double-click on the new tab, and click Text in the Design tab.

7. (Optional) Rename your tab to Profiler.

8. Open the Insert Control tab at the top of the page, then click Browser and drag it to the design

space for your tab.

9. Click the browser control to select it.

10. Open the Design tab at the top of the page.

11. In the Options section of the Design tab, click URL , and enter the simplified login URL:

https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddress=$conta
ct.email.addr



©2025 Oracle Corporation. All rights reserved 65 of 269

To use the legacy URLs, replace the URL value above with the Legacy login URLs

12. Check the Send URL as Post Data and Open Pop-ups in New Browser Control check boxes.

13. Click Save.

Profiler is now embedded within the context of your workspace in an iframe.

Adding a Profiler link to Oracle Sales

ZImportant: Oracle Sales was formerly known as Oracle Sales Cloud. All instances

of Oracle Sales Cloud have been changed to Oracle Sales across the app user

interface.

There are two main steps that you must follow to add a Profiler link to your Oracle Sales

(formerly Oracle Sales Cloud) account:

1. Create a Profiler link

2. Add the link to a layout

Step 1: Creating a Profiler link.

To create a Profiler link:

1. Log in with your Administrator credentials.

2. Click the Navigator icon, then under Configuration click Application Composer.

3. In the left-side pane, select Marketing from the Application drop-down list.

4. In the left-side pane under Objects, expand Standard Objects > Sales Lead > Sales Lead

Contacts, then select Actions and Links .
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5. Click Create to create a link, then enter the following information:

l Display Label: Profiler

l Name: Eloqua_Profiler

l Type: Select Link

l URL Definition: Enter the simplified login URL:

def URL="https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddress=" + nvl
(PrimaryEmailAddress,"")

To use the legacy URLs, replace the URL value above with the Legacy login URLs.

6. Click Validate to validate the script.

7. Click Save.

Step 2: Adding the Profiler link to layouts

To add the Profiler link to a layout:

1. In the Application Composer left-side menu, navigate to Standard Objects > Sales Lead, then

click Pages.

2. Under Simplified Pages, locate the Details Page Layouts section, then click on the name of the

layout to which you want to add the link.

3. In the Subtabs Region section, open the Contacts tab.

4. Click Edit next to Contacts.

5. Under the Available Fields column, select the Profiler link that you created then click to

move the link to the Selected Fields column.

6. Adjust the link's location in the Selected Fields list using the up and down arrows next to the list,

then click Save and Close.
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When you open to a customer you will see the Profiler link.

Embedding Profiler in CRM onDemand

When embedding Profiler in CRM onDemand, there are two main steps that you must

follow:

1. Create a web applet

2. Add the web applet to a page layout

ëNote: You will need to create two applets– one for leads and one for contacts. The

instructions below are for Contacts but you can follow the same procedure for

Leads.

Step 1: Creating a web applet for contact and leads

Prerequisites:

l In Oracle Eloqua, build an allowlist of the domains that will be hosting embedded Profiler pages.

Learn how to configure Profiler.

To create a web applet:
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1. Login to CRM onDemand with your Administrator credentials.

2. Navigate to User > Configure > Admin.

3. Click Application Customization.

4. Under Record Type Setup, click Contact.

5. Under Pay Layout Management, click Contact Web Applet, then enter the information below:

l Name: Enter a name. ( Example: Eloqua Profiler)

l Location: Select Detail Page

l Type: Select URL

l URL: and enter the simplified login URL:

https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddress%3D%%%Email_
Address%%%

To use the legacy URLs, replace the URL value above with the Legacy login URLs.

l Height: Enter 800
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6. Click Save.

Step 2: Adding webs applet to page layouts

To add an applet to a page layout

1. Navigate to User > Configure > Admin.

2. Click Application Customization.

3. Under Page Layout Management, click Contact Page Layout.

4. Choose the page layout that you want to modify

5. It is not necessary to configure Steps 2 or 3. Click Step 4 (Related Information) to continue.

6. In the Not Available Information column, locate the web applet that you created, then highlight it

(single left-click) and click the > arrow to move it to the Available Information column.

7. Select the applet in the Available Information column, then click the > arrow to move it to the

Displayed Information column.

8. Click Finish.

ZImportant: Repeat the above steps for Leads
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Embedding Profiler in Microsoft Dynamics 2016

Profiler can be embedded in Microsoft Dynamics.

Prerequisites:

l In Oracle Eloqua, build an allowlist of the domains that will be hosting embedded Profiler pages.

Learn how to configure Profiler.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more. The steps below

assume you are using the simplified login URL.

To install Profiler in Dynamics:

1. Navigate to Menu > Settings > Customization > Customizations > Customize the System.

2. Under Components, select Entities > Contact > Forms.

3. Click New, then select the form to which you want to add Profiler.

4. Click the Insert tab in the top menu.

5. Add a one-column tab.

6. Add an iframe to this tab.

l Name: IFRAME_Profiler

l URL: http://about:blank
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l Label: Eloqua Profiler

l Ensure that Restrict cross-frame scripting is unchecked

7. On the Formatting tab, modify the height by setting the number of rows, such as 20.

8. On the Dependencies tab, add email as a dependent field.

9. Click OK to close the IFRAME window.

10. On the Home tab, click Form Properties in the Form section.

11. Under Form Libraries, click Add, then click New.
l Name: new_EPPOnLoad

l Type: Script (JScript)

12. Click the text editor button that appears.

13. In the text editor, copy and paste the following string: function loadProfiler() {

14. Copy and paste one of the simplified login URL code snippet below. To use the legacy URLs,

replace the URL value above with the Legacy login URLs.

var newUrl = https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddres

s=" + document.getElementById

("emailaddress1").title;Xrm.Page.ui.controls.get("IFRAME_

Profiler").setSrc(newUrl);

15. Be sure to close everything with a final }. If you chose auto-login, your code should look

something like this:

function loadProfiler() {var newUrl =

"https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddres

s="+ document.getElementById
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("emailaddress1").title;Xrm.Page.ui.controls.get("IFRAME_

Profiler").setSrc(newUrl);}

16. Click OK to close the text editor.

17. Click Save, then click Publish, and close the window.

18. Close the Look Up Record window.

19. Under Event Handlers, click Add.

20. Select the new function you created from the list and then name it.

21. Click OK.

22. Click OK in the Form Properties window.
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23. Click Save, then click Publish on your form.

24. Repeat for the Leads entity if needed.

ZImportant: If the IFRAME window appears blank, navigate to Settings >

Administration > System Settings > General, and change the setting for Use

legacy form rendering to Yes. Microsoft Dynamics will then correctly render the

Profiler iframe.

Embedding Profiler in Microsoft Dynamics 365

You can add Profiler to your Microsoft Dynamics 365 instance.

Prerequisites

l If you are using version 9 and above of Microsoft Dynamics 365, see Version 9 and above.

l A Microsoft Dynamics 365 instance and the permissions needed to customize it.

l In Oracle Eloqua, build an allowlist of the domains that will be hosting embedded Profiler pages.

Learn how to configure Profiler.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more. The steps below

assume you are using the simplified login URL.

Version 9 and above

If you are using version 9 and above of Microsoft Dynamics 365, you will need to perform

some steps differently:

l If Profiler is already embedded in your Microsoft Dynamics 365, you'll need to make the below

changes, save them, then publish them.
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l For step 13 in the Handler Properties window, make sure Pass execution context as first

parameter is enabled.

l You'll need to use the simplified login URL code snippet for step 18:

loadProfiler(executionContext){

var newUrl = "https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddres

s=" + executionContext.getFormContext().getAttribute

("emailaddress1").getValue();Xrm.Page.ui.controls.get("IFRAME_

Profiler").setSrc(newUrl);

}

To embed Profiler in Microsoft Dynamics 365:

1. Log in to Microsoft Dynamics 365 and navigate to Settings.

2. In the Customization section, click Customizations.
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3. On the Customization page, click Customize the System.

4. On the PowerApps page, under Components, select Entities > Contact > Forms.

5. Click New, then select the form you want to add Profiler to, such as Main Form.

6. Click the Insert tab in the top menu.
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7. Add a One Column Tab select the new tab and click IFRAME to add an iframe to it.

The Add an IFRAME window is displayed.
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8. Enter the following iframe values.

a. Name: IFRAME_Profiler

b. URL: http://about:blank

c. Label: Eloqua Profiler

d. In the Security section, clear the Restrict cross-frame scripting option.



©2025 Oracle Corporation. All rights reserved 78 of 269

9. (Recommended) In the Row Layout section of the Formatting tab, increase the height by setting

the number of rows to 20 so that Profiler will have enough room to display its information.

10. On the Dependencies tab, add email as a dependent field.

11. Click OK to close the Add an IFRAME window.

12. On the Home tab, click Form Properties.

The Form Properties window is displayed.

13. Click Add. The Handler Properties window is displayed.

ZImportant: If you are using Microsoft Dynamics 365 version 9 and above, see Version 9
and above for additional steps in the Handler Properties window.
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14. From the Library list, select new_EPPOnLoad.

15. In the Function box, enter loadProfiler and click OK.

16. Double-click your new iframe. The IFRAME Properties window is displayed.

17. On the Events tab, expand Form Libraries and double-click new_EPPOnLoad. The Edit

Content window is displayed.

18. Depending on your login type, copy and paste one of the following code snippets into the code

editor:

ZImportant: If you are using Microsoft Dynamics 365 version 9 and above, see Version 9
and above for the code snippets. Ignore the below code snippets for step 18.

function loadProfiler() {

var newUrl = https://login.eloqua.com/siteLogin?SiteName=
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{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddres

s=" + document.getElementById("

{emailaddress1}").title;Xrm.Page.ui.controls.get("IFRAME_

Profiler").setSrc(newUrl);

}

19. Replace the {emailaddress1} with the value in your Microsoft Dynamics 365 instance. For

example, it can be emailaddress1, emailaddress1_d, or emailaddress1_i. To determine

what is used in your Microsoft Dynamics 365 data, inspect an existing contact's email address

with your browser's developer tools. For example, to find your value using Google Chrome:

i. Go to Sales > Contacts and click an existing contact.

ii. Pressing Ctrl+Shift+I to open developer tools.

iii. On the Elements tab, press Ctrl+F and search for emailaddress1.

iv. The value associated with the contact's email address field that is followed by title="

{emailAddress}" indicates the value you need to include. In the following example, the needed value

is emailaddress1_d.
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-Example: If you chose autologin, your {LoginPrefix} is ELQA, and your {emailaddress1}
value is emailaddress1_d, your code should look something like this:

function loadProfiler(){

var newUrl =

"https://login.eloqua.com/autoLogin?LoginPrefix=ELQA&Url=/apps/em

bed/salesTools/profiler?emailAddress="+ document.getElementById

("emailaddress1_d").title;Xrm.Page.ui.controls.get("IFRAME_

Profiler").setSrc(newUrl);

}

20. Click OK to close the text editor.

21. On the Home tab, click Save, click Publish, and then close the PowerApps window.

22. Go to Contacts and open a contact that is known to exist in both Oracle Eloqua Profiler and

Microsoft Dynamics 365 to test that your new Eloqua Profiler iframe is working. If you are

prompted to authenticate, enter your Eloqua credentials. If there is a match based on the email

address, the Profiler iframe should display information for the contact.
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ZImportant: If the IFRAME window appears blank, navigate to Settings >

Administration > System Settings > General, and change the setting for Use

legacy form rendering to Yes. Microsoft Dynamics will then correctly render the

Profiler iframe.

Embedding Profiler in Salesforce Classic

ëNote: If you are using Salesforce Lightning, see Embedding Profiler in Salesforce

Lightning.

The users that can see Eloqua Profiler in your CRM system are dependent on the

views/layouts you have set up in your CRM system and on which of those views/layouts

you insert the Eloqua Profiler component.
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ëNote: If you want to test Eloqua Profiler without making it available to your entire

sales or marketing team, you should assign yourself a contact/lead view to which

nobody else has access and then add Eloqua Profiler to that view.

Prerequisites:

l In Oracle Eloqua, build an allowlist of the domains that will be hosting embedded Profiler pages.

Learn how to configure Profiler.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more.

There are three main steps you must follow when installing Profiler using Visualforce:
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1. Create a Visualforce page for contacts and leads

2. Adjust security for Visualforce pages

3. Add Visualforce pages to contact and lead layouts

¤Tip: If you encounter any issues, see Troubleshooting.

Step 1: Creating a Visualforce page for contacts and leads

You will need to create two (2) Visualforce pages – one for leads and one for contacts.

Then you will be editing your existing Contact and Lead views by inserting the

appropriate Visualforce pages into their corresponding views. Below, we will cover the

installation for a Lead view, however, the steps required for a Contact view are mostly the

same but for a few minor text items noted below.

To create a Visualforce page:

1. Log into your Salesforce account using your administrator credentials, then navigate to Setup

in the upper right-hand corner of the screen.

2. Navigate to Develop (under Build section) > Visualforce Pages > New.
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3. Provide a Label and a Name for the Visualforce page.

ëNote: These two fields will only be used when managing layouts and sections and will
not be visible to users simply reviewing a lead record. The name can be whatever you

want but it must contain only alpha-numeric characters and must not have any spaces.
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4. In the Visualforce Markup tab, enter the URL depending on your login method:
l Simplified login: <apex:page standardController="Lead"><apex:iframe scrolling="true"

src="https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddress=
{!lead.email}"/> </apex:page>

l To use the legacy URLs, replace the URL value above with the Legacy login URLs.

5. If you wish to enable this on the salesforce1 mobile app, select the check box next to Available

for Salesforce mobile apps.

6. Click Save.

7. Repeat for the contact object.

¤Tip: For your contacts Visualforce page, replace {!lead.email} with
{!contact.email}.

Step 2: Adjusting security for Visualforce pages

Salesforce has default security that prevents certain users from viewing Visualforce

pages unless the security on those individual pages is customized.

To adjust the security for a Visualforce page:
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1. Navigate to Develop (under Build section) > Visualforce Pages.

2. Click Security next to the pages you created.

3. Add the user types that should be able to view Eloqua Profiler to the Enabled Profiles list.

4. Click Save.

Step 3: Adding Visualforce pages to contact and lead layouts

The steps below describe the procedure for adding the Leads Visualforce page to a

layout. The same steps can be followed for the Visualforce Contacts page you created.

To add a Visualforce page to layouts:

1. Navigate to Setup in the upper right-hand corner of the screen.

2. Navigate to Customize (under Build section) > Leads > Page Layouts.
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3. Select Edit next to the layout in which you would like to insert Eloqua Profiler (either the one you

are testing or the one that your sales team uses to review Lead records).

4. Drag the button located near the top of your screen to create a new section in your

layout to contain Eloqua Profiler.
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5. Place the new section into the area of the layout in which you would like Eloqua Profiler

displayed.

6. Name the section. Ensure that the two check boxes are selected, and select a 1-Column

Layout.

ëNote: The section name is what will be displayed above the section within the Lead
view. Ensure that the name is something that will be relevant and intuitive to your sales

users.

7. Go back to the top area (the area from which you dragged and dropped the new section) and

scroll down if necessary to select Visualforce Pages (in the area just to the left of the buttons

area).

8. Drag the button for the new Visualforce page you made into the new section you just created.

You have now included Eloqua Profiler in your layout. Now let's adjust the settings for this new

section.

9. Hover over the top right corner of the Visualforce page (inside the Section) until a wrench icon

appears. Make sure it is the one for the Visualforce page and not the entire section.

10. Click on the wrench icon. In the VisualForce Page Properties, ensure that the width is set to

100% and the height is set to 610.

11. Click Save to save this layout.

ZImportant: Repeat the above steps for the layout of your Contact object.

12. When you return to the Leads tab in Salesforce and click on a lead, the new Visualforce page

containing Profiler is displayed in the new section you added.
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Troubleshooting

l If the iframe is not connecting, copy the URL you were trying to use in the Visualforce Markup

tab (this will be the text between src=" and the next "), and enter it into a browser to test that it

works on its own. Depending on the URL type, you might need to already be logged into

Profiler.

l If you see a content security policy directive message in the iframe, check that your Profiler

allowlist includes the required URLs for embedding in Salesforce. Make sure to also confirm

that the URL you are using is correct and includes /embed/.

l If you're experiencing trouble with your SSO, see Testing single sign-on with Salesforce for

other troubleshooting tips.

l If you have several IDPs setup with your SSO configuration, adjust the URL to use the specific

IDP you want. Otherwise, the default IDP will be used.

Here is an example URL with the IDP parameter:

https://login.eloqua.com/siteLogin?SiteName=ExampleSiteName&Idp=696

27DAC73E04DE79CDFC90D132B65EA&ReturnUrl=/apps/embed/salesTools/prof

iler

l If the Profiler iframe is trying to open a contact whose email address includes a + symbol, you'll

encounter a Whitelabel Error Page error. To fix this, add URLENCODE to the URL in the

Visualforce Markup tab: ...profiler?emailAddress={!URLENCODE(lead.email)}.

Make sure to remove the ! from !lead.email and place one before URLENCODE, and to add
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parentheses around lead.email.

l For Firefox users, if you’re using the legacy Autologin or SAML access methods, and you

cannot progress past the Eloqua authenticate now login screen, you may have to disable

Firefox enhance tracking protection. To do this, in Firefox, navigate to Options in the Firefox

browser > Privacy & Security > Enhanced Tracking Protection > select Custom > uncheck the

box for Cookies.

l If none of the above troubleshooting tips have solved your issue, please log in to My Oracle

Support (https://support.oracle.com) and create a service request.

Embedding Profiler in Salesforce Lightning

ëNote: If you are using Salesforce Classic, see Embedding Profiler in Salesforce

Classic.

The users that can see Eloqua Profiler in your CRM system are dependent on the

views/layouts you have set up in your CRM system and on which of those views/layouts

you insert the Eloqua Profiler component.

https://support.oracle.com/
https://support.oracle.com/
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ëNote: If you want to test Eloqua Profiler without making it available to your entire

sales or marketing team, you should assign yourself a contact/lead view to which

nobody else has access and then add Eloqua Profiler to that view.

Prerequisites:

l In Oracle Eloqua, build an allowlist of the domains that will be hosting embedded Profiler pages.

Learn how to configure Profiler.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more.

There are three main steps you must follow when installing Profiler using Visualforce:

1. Create a Visualforce page for contacts and leads

2. Adjust security for Visualforce pages

3. Add Visualforce pages to contact and lead layouts
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¤Tip: If you encounter any issues, see Troubleshooting.

Step 1: Creating a Visualforce page for contacts and leads

You will need to create two (2) Visualforce pages – one for leads and one for contacts.

Then you will be editing your existing Contact and Lead views by inserting the

appropriate Visualforce pages into their corresponding views. Below, we will cover the

installation for a Lead view, however, the steps required for a Contact view are mostly the

same but for a few minor text items noted below.

To create a Visualforce page:

1. Log into your Salesforce account using your administrator credentials, then navigate to Setup

in the upper right-hand corner of the screen.

2. Locate the Quick Find search box, and search for Visualforce Pages

Alternatively, you can click Custom Code > Visualforce Pages.

3. Click New.

4. Provide a Label and a Name for the Visualforce page.

ëNote: These two fields will only be used when managing layouts and sections and will
not be visible to users simply reviewing a lead record. The name can be whatever you

want but it must contain only alpha-numeric characters and must not have any spaces.

5. In the Visualforce Markup tab, enter the URL depending on your login method:
l Simplified login: <apex:page standardController="Lead"><apex:iframe scrolling="true"

src="https://login.eloqua.com/siteLogin?SiteName=
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{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler?emailAddress=
{!lead.email}"/> </apex:page>

l To use the legacy URLs, replace the URL value above with the Legacy login URLs.

6. If you wish to enable this on the mobile app, select the check box next to Available for

Salesforce mobile apps.

7. Click Save.

8. Repeat for the contact object.

¤Tip: For your contacts Visualforce page, replace {!lead.email} with
{!contact.email}.

Step 2: Adjusting security for Visualforce pages

Salesforce has default security that prevents certain users from viewing Visualforce

pages unless the security on those individual pages is customized.

To adjust the security for a Visualforce page:

1. Locate the Quick Find search box, and search for Visualforce Pages

Alternatively, you can click Custom Code > Visualforce Pages.
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2. Click Security next to the pages you created.

3. Add the user types that should be able to view Eloqua Profiler to the Enabled Profiles list.

4. Click Save.

Step 3: Adding Visualforce pages to contact and lead layouts

The steps below describe the procedure for adding the Leads Visualforce page to a

layout. The same steps can be followed for the Visualforce Contacts page you created.

To add a Visualforce page to layouts:
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1. Locate the Quick Find search box, and search for Object Manager.

Alternatively, you can click Objects and Fields > Object Manager.

2. Click Lead > Page Layouts.

3. Click on the layout in which you would like to insert Eloqua Profiler (either the one you are

testing or the one that your sales team uses to review Lead records).

4. Drag the button near the top of your screen to create a new section in your layout to

contain Eloqua Profiler.

5. Place the new section into the area of the layout in which you would like Eloqua Profiler

displayed.

6. Name the section. Ensure that the two check boxes are selected, and select a 1-Column

Layout.

ëNote: The section name is what will be displayed above the section within the Lead
view. Ensure that the name is something that will be relevant and intuitive to your sales

users.

7. Go back to the Contact Layout section at the top of the page, and click on Visualforce Pages in

the list of options.

8. Drag the button for the new Visualforce page you made into the new section you just created.

You have now included Eloqua Profiler in your layout. Now let's adjust the settings for this new

section.

9. Hover over the top right corner of the Visualforce page (inside the Section) until a wrench icon

appears. Make sure it is the one for the Visualforce page and not the entire section.
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10. Click on the wrench icon. In the Visualforce Page Properties dialog, ensure that the width is set

to 100% and the height is set to 610.

11. Click OK.

12. Click Save to save this layout.

ZImportant: Repeat the above steps for the layout of your Contact object.

13. When you return to the Leads tab in Salesforce and click on a lead, the new Visualforce page

containing Profiler is displayed in the new section you added.

Troubleshooting

l If the iframe is not connecting, copy the URL you were trying to use in the Visualforce Markup

tab (this will be the text between src=" and the next "), and enter it into a browser to test that it

works on its own. Depending on the URL type, you might need to already be logged into

Profiler.

l If you see a content security policy directive message in the iframe, check that your Profiler

allowlist includes the required URLs for embedding in Salesforce. Make sure to also confirm

that the URL you are using is correct and includes /embed/.

l If you're experiencing trouble with your SSO, see Testing single sign-on with Salesforce for

other troubleshooting tips.



©2025 Oracle Corporation. All rights reserved 98 of 269

l If you have several IDPs setup with your SSO configuration, adjust the URL to use the specific

IDP you want. Otherwise, the default IDP will be used.

Here is an example URL with the IDP parameter:

https://login.eloqua.com/siteLogin?SiteName=ExampleSiteName&Idp=696

27DAC73E04DE79CDFC90D132B65EA&ReturnUrl=/apps/embed/salesTools/prof

iler

l If the Profiler iframe is trying to open a contact whose email address includes a + symbol, you'll

encounter a Whitelabel Error Page error. To fix this, add URLENCODE to the URL in the

Visualforce Markup tab: ...profiler?emailAddress={!URLENCODE(lead.email)}.

Make sure to remove the ! from !lead.email and place one before URLENCODE, and to add

parentheses around lead.email.

l For Firefox users, if you’re using the legacy Autologin or SAML access methods, and you

cannot progress past the Eloqua authenticate now login screen, you may have to disable

Firefox enhance tracking protection. To do this, in Firefox, navigate to Options in the Firefox

browser > Privacy & Security > Enhanced Tracking Protection > select Custom > uncheck the

box for Cookies.

l If none of the above troubleshooting tips have solved your issue, please log in to My Oracle

Support (https://support.oracle.com) and create a service request.

Embedding Profiler in Okta with SSO

Learn how to access Profiler if your are using Okta SSO.

https://support.oracle.com/
https://support.oracle.com/
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Overview

The high level configuration steps are as follows:

1. Ensure you have setup single sign-on in Oracle Eloqua. Learn more.

2. If you will be embedding Profiler within a CRM or other apps, create the allowlist of domains that

will host Profiler pages. Learn more.

3. Understand how to access Profiler:

l Accessing Profiler with Okta SSO

l Accessing Profiler as an Okta app

Accessing Profiler with Okta SSO

Profiler is an app you can access via a URL from any location. It could be launched

standalone in a browser but is most commonly embedded inside a CRM system.

To access Profiler with Okta SSO:

1. Enter the following URL:

l To launch Profiler standalone in a browser: https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler

l To embed Profiler in a CRM or other app: https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&ReturnUrl=/apps/embed/salesTools/profiler

Once you have this properly formatted URL, as long as a user has an Okta session active

in their browser, they can access Profiler.

Accessing Profiler as an Okta app

To allow users direct access to Profiler from apps in Okta:

OverviewSSOwithIdPConfiguration.htm


©2025 Oracle Corporation. All rights reserved 100 of 269

1. In Okta, create a new Okta app for Profiler.

2. While creating the SAML2 template, add the following to the Default Relay State field:

ReturnURL=%2Fapps%2FsalesTools%2Fprofiler

¤Tip: You can append additional parameters to this URL. For example, to open Profiler
to a specific contact. Learn more.
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Engage

Engage is one of Eloqua's Sales Tools. It alleviates the need to constantly recreate

emails that are frequently used throughout the sales process. Ensuring sales

professionals are using marketing-approved messaging, branding and content, it also

allows for personalization and tracking of each email sent. Engage's responsive design

makes it easy for sales professionals to send relevant, trackable emails on the go from

their mobile phones and tablets.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SalesTools
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What's in it for the marketing side of the house?

l Create your "sales-emails" in the same place you create your regular marketing campaign

emails.

l Control the marketing content your sales team sends out to their prospects.

l When sales adds a new contact on the fly, it is synchronized with Eloqua and your CRM.

l Emails sent through Engage are recorded in Eloqua and within the CRM and Profiler on the

contact record.

Learn more by watching this video: https://www.youtube.com/playlist?list=PLw7GyH-

Hj8cN_oEV8epjsq-PB0uRUOC4E

ëNote: Before you can access the responsive version of Engage, it must be

installed in your Eloqua instance. Once installed, the customer administrator can

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Profiler
https://www.youtube.com/playlist?list=PLw7GyH-Hj8cOn_extHBh51Q7fl2XycpgK
https://www.youtube.com/playlist?list=PLw7GyH-Hj8cOn_extHBh51Q7fl2XycpgK
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customize the options that appear to those using the program. Learn more about

installing and configuring Engage.

Steps to setup Engage

Setting up Engage involves installation, configuration, user setup, and email template

design. Use the table below to help guide you through the setup process.

Step Description

Installing Engage Install the Engage app in your instance. A customer

administrator should perform the install.

See Installing Engage.

Configuring the Engage appConfigure the Engage app for your organization’s needs.

You can configure settings like:

l How many recipients can be added to an email and whether to

limit the number of sends to an individual contact.

l What controls users have access to in the Engage email

editor.

l Override the default sender address for all Engage emails.

See Configuring Engage.

Setting up Engage users To use Engage, users must have the Engage license and

appropriate asset permissions. Additionally, if users will be

using the Oracle Eloqua Sales Tools for Microsoft Outlook,

users must have the Eloqua Sales Tools for Microsoft
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Step Description

Outlook license.

To use an email template, Engage users must have view

access to view all assets associated with the template:

l Email template, template headers and footers

l Any landing page or associated form referenced by an email

template

l Cascading asset permissions from there may also be required

- for example, assets referenced by form processing rules

We recommend assigning Engage users to the following

security groups:

l Engage Users

l Active Users Sales

These groups grant the appropriate licenses and ensure

that View permissions are granted to appropriate assets. If

you customize security groups or default asset permissions,

consider the impact to your Engage users. Learn more

about security groups.

Engage users can be

l Imported from your CRM and assigned appropriate security

groups. See Creating user imports using the Salesforce

Integration app or Creating user imports using the Oracle CX

Sales Integration app.

l Set up manually. See Creating individual users or Uploading

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SecurityGroups
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SecurityGroups
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=AppSalesforceCreatingUserImports
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=AppSalesforceCreatingUserImports
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=AppOracleSalesCloudCreatingUserImports
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=AppOracleSalesCloudCreatingUserImports
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=CreatingUsers
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=UploadingUsersUsingCSV
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Step Description

multiple user accounts.

Allowing Engage users to

create contacts

By default, Engage users cannot create new Eloqua

contacts. If you want to allow users to create contacts, grant

users the Manage Contacts action permission. See action

permissions.

You should then also ensure the Engage users have access

to the appropriate contact views. See Configuring Eloqua

contact views in Sales Tools.

Setting up email group

access

Email templates are made available to Engage users based

on email group access. If the Engage user has access to the

group, they can access emails assigned to that group.

In addition, if you allow Engage users to create their own

templates for sharing with other Engage users, they can

choose the email group for that email.

See Making a template available in Engage and Email

groups.

Creating Engage templates Now you can create your Engage templates. Make sure

templates are assigned to the correct email group from the

previous step. Additionally, Engage users must have view

access to the email and any assets referenced in the email

(landing page, form, custom object, etc.)

See Making a template available in Engage.

Creating signature layouts If you want Engage emails to use a standard signature,

setup and configure the signature layouts. You can add the

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=UploadingUsersUsingCSV
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ActionPermissions
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ActionPermissions
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ContactViewsSalesTools
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ContactViewsSalesTools
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailGroups
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailGroups
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Step Description

signature layout to Engage templates, and they are also

available from the Engage email toolbar. Engage users

must have view access to use the signature layout. See

Signature layouts.

If you allow Engage users to send personal emails (blank

emails), they can also set up their own signature using the

Engage app. See Creating an email signature.

Testing Engage templates It is important to test the Engage templates you’ve set up as

if you were an Engage user. Consider setting up a test

Engage user in Eloqua with the same configuration as a

Engage user. Use this user account to do all of your Engage

testing. Learn more about accessing Engage.

If your users will be using the Oracle Eloqua Sales Tools for

Microsoft Outlook add-in, be sure to test your templates in

Microsoft Outlook as well. Learn more about the Microsoft

Outlook add-in.

Accessing Engage Work with your sales organization to determine the best

method for accessing Engage.

l Integrate Engage with your CRM

This would allow sales users to access engage directly from

the CRM. You can embed Engage as a tab, link to it as a

button, etc. See Engage integration.

l Use the Oracle Eloqua Sales Tools for Microsoft Outlook add-

in

This is an add-in that your users can install on their own or

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SignatureLayouts
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Step Description

your IT department can deploy to an entire organization. See

Oracle Eloqua Sales Tools for Microsoft Outlook.

l Direct link

This is a customizable link you can use to launch Engage

directly.

Learn about the URL structure for access engage and the

optional parameters that can be used to open a specific

template, recipient, and so on. See Accessing Engage.

Onboard Engage users Now you can onboard your Engage users. Be sure to give

them an overview of the tool, templates, and appropriate

usage guidelines from your organization. Also considering

how you will share templates with users going forward.

See Using Engage for tasks related to using Engage.

Report and monitor After sales reps start using Engage, you can use Insight

reports to monitor template performance and overall usage.

Start with these reports available from the Insight catalog:

l Sales Email Overview report

l Sales Email Template Usage report

l Sales Email Opens and Website Visits report

Sales reps can also review the performance for their sent

messages. Refer to the following topics for more

information:

l Engage reports

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SalesToolsMicrosoftOutlook
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Step Description
l Viewing email performance using Microsoft Outlook

Making a template available in Engage

Engage integration

Installing Engage

Before you can use Engage, a user with customer administrator rights must install the

app and configure the settings for your Oracle Eloqua instance.

Z
Important: Because deleting or deactivating the installer user account will impact

installed apps, we recommend installing apps using a user account that is not tied

to a specific person. The user account must have customer administrator rights.

Learn more about the steps to setup Engage.

To install the Engage app:

1. Follow the Engage installation URL below:

https://login.eloqua.com/Apps/Cloud/Admin/Catalog/Add/d321bf52-fd08-4b3f-b5fa-

96448cc466b9/00-14-9C-60-13-3C-AA-E3-2E-9A-2B-E9-7D-B1-B3-B6

2. Log in with your Eloqua credentials, if required.

3. Click Accept and Install to add the app to your Apps list.

http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=OutlookEmailPerformance
https://login.eloqua.com/Apps/Cloud/Admin/Catalog/Add/d321bf52-fd08-4b3f-b5fa-96448cc466b9/00-14-9C-60-13-3C-AA-E3-2E-9A-2B-E9-7D-B1-B3-B6
https://login.eloqua.com/Apps/Cloud/Admin/Catalog/Add/d321bf52-fd08-4b3f-b5fa-96448cc466b9/00-14-9C-60-13-3C-AA-E3-2E-9A-2B-E9-7D-B1-B3-B6
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4. Configure Engage Global Settings. Learn more.

5. Click Save.

6. Click Accept or switch users.

The app is now installed and can be viewed in your Apps list (Settings > Apps, under

the Platform Extensions section). Select an app to view a description, modify the

configuration settings, reinstall, or uninstall it. You can also check its status and

dependencies.

qWarning: To modify configuration settings, navigate to Apps, select your app, and

click the Configure icon . Selecting the Reinstall icon will force you to go

through the entire configuration process again. The app will be unavailable for all

users during the reinstall. All existing assets, configurations and history are

preserved when you reinstall an app. Also, you can choose to delete an app by

clicking the Uninstall . In this case, all current assets, configurations, and history

are permanently deleted.

Settings

Recipients

l Restrict the maximum number of recipients to: Specify the maximum number of recipients a

single email can be sent to. The highest number you can enter for this field is 2,000.

l Enable recipient autocompletion: When enabled, Engage searches your Oracle Eloqua

contacts as their names are entered in the recipient list in an email. This option is disabled by

default.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Apps
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l Enable contact send limit: Limit the number of sales emails that your reps can send to the

same contact over a period of time. For example, if you enable the option today, with the

number of days set to 7 and the send limit set to 1, Eloqua will look back at the last 7 days to

determine if there has been 1 email sent out to a given contact from Engage. If no email has

been sent out over the last 7 days, the sales rep will be able to send one email to that contact.

These limits can help you prevent contact fatigue and unsubscribes, which also helps maintain

your domain's reputation.

¤Tip: Send limits apply to both Engage and Oracle Eloqua Sales Tools for

Microsoft Outlook. and apply to all sales users.

Email Settings

In the Email Settings section, you can standardize the sender display name and from

address of all emails sent from Engage.

By default, Engage sends emails using the user’s first name, last name, and email

address. Using the Email Settings, you can change these defaults and have all Engage

emails sent with the same sender display name and from address.

Consider using these settings if you want to help the sales team with their email branding,

and help your sender reputation. A best practice for a strong sender reputation is

matching the from address to the return path. These settings allow you to do this.

The reply-to address for Engage emails is always the email address of the Engage user.

For example, when John Smith sends an Engage email, John's email address is used

when a contact replies to the email.
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ëNote: These settings should match the values configured within the Email

Defaults settings page. Only change these settings if you have access to these

settings. Learn more about email defaults.

l Customize how emails are sent from Engage: Check this box to customize two fields: Sender

display name and From address.
l Sender display name: All emails sent from Engage will display this sender name to recipients. For

example, if you enter the value Company Name, recipients will see Company Name for the sender

name when John Smith sends an Engage email. If you leave this value blank, Engage will continue to

use the user’s information (for example, John Smith).

l From address: All emails sent from Engage will display this from address to recipients. For example,

if you enter the value products@companyname.example.com, recipients will see

products@companyname.example.com for the from address when John Smith sends an email.

¤Tip: If you enable this setting, be sure to review your signature layouts for any

necessary changes. Learn more about signature layouts.

Email Creation

l Allow use of blank templates: When enabled, Engage users can send a non-templated blank

email. When disabled, Engage users can only use Engage templates created for them. This

option is enabled by default. Review the considerations when enabling this feature.

l Allow creation of shared templates: When enabled, Engage users with appropriate

permissions can save Engage emails and make them accessible to other users. This option is

enabled by default. All users are able to save Engage emails for private use.

http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=SettingGlobalEmailDefaults
http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=SignatureLayouts
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Content

l Allow images: When enabled, Engage users can insert images in emails. Images are stored in

the Oracle Eloqua image library and require appropriate asset permissions. This option is

enabled by default. Learn more about inserting images.

l Allow attachments: When enabled, Engage users can insert attachments in emails.

Attachments are stored in Oracle Eloqua's File Storage library and require appropriate asset

permissions. This option is enabled by default. Learn more about inserting attachments.

l Enable field merges: When enabled, Engage users can insert field merges in emails. Field

merges are stored in Eloqua's File Storage library and require appropriate asset permissions.

This option is enabled by default. Learn more about inserting field merges.

Text Formatting

l Enable font colors and font highlighting: When enabled, Engage users can modify the font

color and highlight selected text. This option is enabled by default.

l Enable font and font size selection: When enabled, Engage users can modify the style and

size of their text. This option is enabled by default.

Template Sorting

l Recently Modified (the default): When enabled, templates are sorted on the All and My tabs of

Engage's Select a Template window according to the date when they were modified. Users can

alternatively click the refine icon and select Alphabetical.

l Alphabetical: When enabled, templates are sorted alphabetically on the All and My tabs of the

Select a Template window. Users can alternatively click the refine icon and select Recently

Modified.

Allowed Domains

Identify which domains are allowed to host Sales Tools pages. For example, if you

embed Sales Tools in an iframe hosted by your CRM, add the domain of the page hosting
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the iframe to your allowlist. You can allow a domain and its sub-domains using a wildcard

(*). Learn more about Engage integration.

To avoid broken iframes, add your CRMs to the Profiler allowlist and Engage allowlist,

and update the Sales Tools URLs you have embedded in an iframe to the new URLs.

Here is a list of suggested domains for the allowlist based on CRMs:

l Salesforce: *.force.com, *.salesforce.com, *.my.salesforce.com, *.lightning.force.com, and

*.visualforce.com

l Oracle CX Sales: *.oraclecloud.com

l Oracle CRM On Demand: *.crmondemand.com

l Microsoft Dynamics: *.dynamics.com

To learn more about embedding Engage in different CRMs, see Engage integration.

Considerations when allowing blank emails

You can enable your sales reps to create blank emails. Blank emails are non-templated

emails. Here are some considerations to take into account about allowing blank emails:

l Blank emails are not associated to an email group. So recipients cannot unsubscribe from

these types of emails sent by your sales users.

l Blank emails will not contain any headers or footers. So this means that unsubscribe links are

not included in these emails.

l In terms of reporting on blank emails in Insight, the emails appear in reports as Tracked Emails.

You cannot report on the subject line of a blank email.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=ReconfiguringProfiler
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=EngageReconfiguring
https://community.oracle.com/topliners/discussion/4476431/eloqua-product-notice-sales-tools-crm-embed-changes-nov-2020-feb-2021
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¤Tip: If you disable this feature, you can create a blank email template for sales

which would give them control over their email but allows you to ensure headers,

footers, and unsubscribe links are included.

Accessing Engage

Overview

Work with your sales organization to determine the best method for accessing Oracle

Engage. You can use any of the following methods:

l Integrate Engage with your CRM

This would allow sales users to access Engage directly from the CRM. You can embed Engage

as a tab, link to it as a button, etc. Learn more.

l Direct link

This is a customizable link you can use to launch Engage directly.

l Use the Oracle Eloqua Sales Tools for Microsoft Outlook add-in

This is an add-in that your users can install on their own or your IT department can deploy to an

entire organization. See Oracle Eloqua Sales Tools for Microsoft Outlook.

l Oracle Eloqua Sales Tools for Google Chrome

The Google Chrome extension allows sales representatives to access Profiler from their

Google Chrome browser. For example, while browsing prospect websites, the sales rep can

open the extension to review Eloqua contacts at that company. Resp can also access Engage

directly from the extension. Learn more.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SalesToolsMicrosoftOutlook
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ëNote: Before your users can access Engage, it must be installed in your Oracle

Eloqua instance. Once installed, the administrator can customize the options that

appear to those using the program. Learn more about installing and configuring

Engage.

Engage URLs

To access Engage , you can use one of the following types of URLs: 

l A simplified login URL that will handle all login flows based on the user logging in and your

Oracle Eloqua configuration. Using this URL, if you have SSO configured for the instance and

user, then the user will be redirected to your default identity provider login screens. If you don't

have SSO, the user will be prompted for their username and password. Learn more.

l A legacy login URL that is specific to the desired login flow and security model at your

organization. There is a separate login URL for auto-login, SAML login, or CVP login. Auto-login

and SAML are options that support Single Sign-On (SSO). Salesforce IDP is an option for

Salesforce SSO logins. Direct login is for logging in directly through Eloqua. Learn more.

Simplified login URL

To access the Engage email composer using the simplified login URL:

https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/salesTools/engage/compose

If you are embedding Engage pages into an iframe, use the following URL. Learn more.

https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose
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The following table describes the supported URL parameters you can use to further

customize the login experience. In addition, you can also add Engage URL parameters to

customize the compose experience. Learn more about Engage URL parameters.

Parameter Description
SiteName=
{company
Name}

Optional

Your instance company name. When provided, users are not prompted to

provide a company name. If the user has an existing session, they will then

be logged in automatically.

Example:

https://login.eloqua.com/siteLogin?SiteName=ExampleSi

teName

ReturnUrl=
{Url}

Optional

The Oracle Eloqua URL to redirect to after logging in.

You must provide the SiteName parameter if you want to use this parameter.

Example:

Redirect to the Engage email compose page:

https://login.eloqua.com/siteLogin?SiteName=ExampleSi

teName&ReturnUrl=/apps/salesTools/engage/compose

Checkfram
e={true or
false}

Optional

Checks if the login page is being accessed from within an iframe and create

a popup window if it is.
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Parameter Description
l true checks for the frame.

l false does not check for the frame. If the result is a displayable page that cannot

be viewed in an iframe, then the user will get a block from their browser. Use only

if it can be guaranteed the current user is already authenticated with the default

SSO used by Oracle Eloqua to skip the popup.

Example:

Checkframe while logging into Engage:

https://login.eloqua.com/siteLogin?SiteName=ExampleSi

teName&CheckFrame=true&ReturnUrl=/apps/salesTools/eng

age/compose

UseDefault
SSO={true
or false}

Optional

Specifies whether or not to use the default identity provider configured for

your instance. Use this parameter if you have multiple identity providers and

want to ensure the default identity provider is used.

l true to use the default SSO

l false to prompt the user to choose the identity provider

Example:

Checkframe while logging into Engage:

https://login.eloqua.com/siteLogin?UseDefaultSSO=true

Idp=
{IdentityPr
oviderId}

Optional

The ID for the identity provider you want to use. Use this parameter if you
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Parameter Description

have multiple identity providers configured for your Oracle Eloqua instance

and you want to use a non-default identity provider. You can retrieve the

identity provider ID from the SSO identity provider screens.

You must provide the SiteName parameter if you want to use this parameter.

Example:

https://login.eloqua.com/siteLogin?SiteName=ExampleSi

teName&Idp=69627DAC73E04DE79CDFC90D132B65EA

Username
=
{username
}&Passwor
d=
{encrypted
Password}

The user name and encrypted password. The password parameter is

encrypted. To retrieve the encrypted version of the user password, you must

open a Service Request with Oracle Support.

You must provide the SiteName parameter if you want to use the user name

and password parameters.

Legacy login URLs

The following lists the legacy login URLs to access to the Engage compose page based

on the desired login methods. These URLs continue to be supported. The URL you use

depends on the security model implemented at your organization. Auto-login and SAML

are options that support Single Sign-On (SSO). Salesforce IDP is an option for Salesforce

SSO logins. Direct login is for logging in directly through Eloqua.

l Direct: https://login.eloqua.com/apps/salesTools/engage/compose

l Auto-login: https://login.eloqua.com/autoLogin?LoginPrefix=

{prefix}&Url=/apps/salesTools/engage/compose

l SAML: https://login.eloqua.com/auth/saml2/autologin?LoginPrefix=

{prefix}&ReturnUrl=/apps/salesTools/engage/compose
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l SFDC IDP: https://{podURL}/sso/sfdc/v1/svp.aspx?LP=

{prefix}&RU=/apps/salesTools/engage/compose

Replace {podURL} with the URL in your browser after you have logged in successfully to

Eloqua (for example, secure.p01.eloqua.com). Click here for additional information about how

to determine your pod.

LoginPrefix values are a unique four-character code for your Eloqua instance. To add this

parameter to your URL, enter LoginPrefix={prefix} where {prefix} is replaced with the four-

character company name. You can obtain your company's login prefix in Eloqua by

navigating to Settings > Display Preferences > Company Defaults.

¤Tip: If SSO with Salesforce is configured, use the SAML or Salesforce IDP login

URL. The SAML URL should be used if SSO with Salesforce is setup using

Eloqua’s SAML capability. The Salesforce IDP login method is only supported if

your organization continues to use the Salesforce native integration and has not

migrated to the Salesforce Integration app. Learn more about SSO configuration.

You can also add additional Engage URL parameters to customize the Engage

experience. Learn more about Engage URL parameters.

Embedding Engage pages

You can embed Engage pages into an iframe, allowing your users to access Engage

directly from other apps at your organization. For example, embed Engage directly into

your CRM.

To embed Engage into an iframe:

https://community.oracle.com/docs/DOC-897330
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1. Update the Engage app with an allowlist of domains that will host Engage pages. Learn more.

2. Adjust the URLs listed above to include /embed/ in the URL: 

/apps/embed/salesTools/engage/compose.

Learn more about Engage integration.

¤Tip: If you are using Microsoft Edge or Sales Tools for Microsoft Outlook to access

the Oracle Eloqua sign in page in an iframe, an addition should be made to trusted

sites. Add https://*.eloqua.com and the URL of the site where the login page

(Oracle Eloqua and/or Sales Tools) is being iframed. The browser must be closed

fully and restarted before the change is recognized. For additional information, see

this Topliners post about Oracle Eloqua login enhancements.

Engage URL parameters

You can add parameters to the Engage compose URL

(apps/salesTools/engage/compose or apps/embed/salesTools/engage/compose)

to pass in recipients, a specific template, or open a blank email.

The table below describes the parameters you can use. Parameters can be combined.

Query
parameter Description

emailAddre

ss=

{emailAddr

ess}

Compose a message for a specific recipient.

For multiple recipients, use commas or semicolons to separate them.

Examples

l

https://community.oracle.com/docs/DOC-1020186
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Query
parameter Description

Compose a new message to person@example.com:
{URL}/compose?emailAddress=person@example.com

l Compose a new message to multiple recipients:
{URL}/compose?emailAddress=person@example.com;person2@example.co
m;person3@example.com

¤Tip: If you are embedding in CRM, you can pass the email address

using the appropriate lead or contact parameter from your CRM. Learn

more about integration.

blank=true Open a blank email.

This option opens a blank email if the Engage administrator has allowed for

blank emails. If the creation of blank emails is not allowed, the Engage

template chooser opens. Learn more about configuring Engage.

Examples

l Compose a new blank email:
{URL}/compose?blank=true

l Compose a new blank email to person@example.com:
{URL}/compose?blank=true&emailAddress=person@example.com

emailId={id}Compose a message using a specific template.

To determine the templateID, open the email in Eloqua and refer to the URL.

The ID is the last portion of the URL.

Examples

l Compose a new message using template ID 581:
{URL}/compose?emailId=581

l
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Query
parameter Description

Compose a new message to person@example.com using template ID 581:
{URL}/compose?emailId=581&emailAddress=person@example.com

Configuring Engage

Manage how your users can use Engage by configuring the Engage app.

Before you begin:

l You must be a customer administrator to configuration the Engage app.

l Some Engage settings do not apply to Sales Tools for Microsoft Outlook sends. See Frequently

asked questions for Sales Tools for Microsoft Outlook.

To configure Engage:

1. Log in to Oracle Eloqua.

2. Click Settings .

3. Click Apps in the Platform Extensions section.

4. Select the Engage app.

5. Click Configure .

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=FAQsForSalesToolsForMicrosoftOutlook
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=FAQsForSalesToolsForMicrosoftOutlook
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qWarning: Selecting the Reinstall option for an app will force you to go through the

entire installation process again. The app will be unavailable for all users during the

reinstall.

6. Configure the settings as needed. Learn more.

7. Click Save to save your settings.

Your configuration settings have been updated. You can modify them at any time.

Settings

Recipients

l Restrict the maximum number of recipients to: Specify the maximum number of recipients a

single email can be sent to. The highest number you can enter for this field is 2,000.
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l Enable recipient autocompletion: When enabled, Engage searches your Oracle Eloqua

contacts as their names are entered in the recipient list in an email. This option is disabled by

default.

l Enable contact send limit: Limit the number of sales emails that your reps can send to the

same contact over a period of time. For example, if you enable the option today, with the

number of days set to 7 and the send limit set to 1, Eloqua will look back at the last 7 days to

determine if there has been 1 email sent out to a given contact from Engage. If no email has

been sent out over the last 7 days, the sales rep will be able to send one email to that contact.

These limits can help you prevent contact fatigue and unsubscribes, which also helps maintain

your domain's reputation.

¤Tip: Send limits apply to both Engage and Oracle Eloqua Sales Tools for

Microsoft Outlook. and apply to all sales users.

Email Settings

In the Email Settings section, you can standardize the sender display name and from

address of all emails sent from Engage.

By default, Engage sends emails using the user’s first name, last name, and email

address. Using the Email Settings, you can change these defaults and have all Engage

emails sent with the same sender display name and from address.

Consider using these settings if you want to help the sales team with their email branding,

and help your sender reputation. A best practice for a strong sender reputation is

matching the from address to the return path. These settings allow you to do this.



©2025 Oracle Corporation. All rights reserved 126 of 269

The reply-to address for Engage emails is always the email address of the Engage user.

For example, when John Smith sends an Engage email, John's email address is used

when a contact replies to the email.

ëNote: These settings should match the values configured within the Email

Defaults settings page. Only change these settings if you have access to these

settings. Learn more about email defaults.

l Customize how emails are sent from Engage: Check this box to customize two fields: Sender

display name and From address.
l Sender display name: All emails sent from Engage will display this sender name to recipients. For

example, if you enter the value Company Name, recipients will see Company Name for the sender

name when John Smith sends an Engage email. If you leave this value blank, Engage will continue to

use the user’s information (for example, John Smith).

l From address: All emails sent from Engage will display this from address to recipients. For example,

if you enter the value products@companyname.example.com, recipients will see

products@companyname.example.com for the from address when John Smith sends an email.

¤Tip: If you enable this setting, be sure to review your signature layouts for any

necessary changes. Learn more about signature layouts.

Email Creation

l Allow use of blank templates: When enabled, Engage users can send a non-templated blank

email. When disabled, Engage users can only use Engage templates created for them. This

option is enabled by default. Review the considerations when enabling this feature.

http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=SettingGlobalEmailDefaults
http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=SignatureLayouts
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l Allow creation of shared templates: When enabled, Engage users with appropriate

permissions can save Engage emails and make them accessible to other users. This option is

enabled by default. All users are able to save Engage emails for private use.

Content

l Allow images: When enabled, Engage users can insert images in emails. Images are stored in

the Oracle Eloqua image library and require appropriate asset permissions. This option is

enabled by default. Learn more about inserting images.

l Allow attachments: When enabled, Engage users can insert attachments in emails.

Attachments are stored in Oracle Eloqua's File Storage library and require appropriate asset

permissions. This option is enabled by default. Learn more about inserting attachments.

l Enable field merges: When enabled, Engage users can insert field merges in emails. Field

merges are stored in Eloqua's File Storage library and require appropriate asset permissions.

This option is enabled by default. Learn more about inserting field merges.

Text Formatting

l Enable font colors and font highlighting: When enabled, Engage users can modify the font

color and highlight selected text. This option is enabled by default.

l Enable font and font size selection: When enabled, Engage users can modify the style and

size of their text. This option is enabled by default.

Template Sorting

l Recently Modified (the default): When enabled, templates are sorted on the All and My tabs of

Engage's Select a Template window according to the date when they were modified. Users can

alternatively click the refine icon and select Alphabetical.
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l Alphabetical: When enabled, templates are sorted alphabetically on the All and My tabs of the

Select a Template window. Users can alternatively click the refine icon and select Recently

Modified.

Allowed Domains

Identify which domains are allowed to host Sales Tools pages. For example, if you

embed Sales Tools in an iframe hosted by your CRM, add the domain of the page hosting

the iframe to your allowlist. You can allow a domain and its sub-domains using a wildcard

(*). Learn more about Engage integration.

To avoid broken iframes, add your CRMs to the Profiler allowlist and Engage allowlist,

and update the Sales Tools URLs you have embedded in an iframe to the new URLs.

Here is a list of suggested domains for the allowlist based on CRMs:

l Salesforce: *.force.com, *.salesforce.com, *.my.salesforce.com, *.lightning.force.com, and

*.visualforce.com

l Oracle CX Sales: *.oraclecloud.com

l Oracle CRM On Demand: *.crmondemand.com

l Microsoft Dynamics: *.dynamics.com

To learn more about embedding Engage in different CRMs, see Engage integration.

Considerations when allowing blank emails

You can enable your sales reps to create blank emails. Blank emails are non-templated

emails. Here are some considerations to take into account about allowing blank emails:

l Blank emails are not associated to an email group. So recipients cannot unsubscribe from

these types of emails sent by your sales users.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=ReconfiguringProfiler
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=EngageReconfiguring
https://community.oracle.com/topliners/discussion/4476431/eloqua-product-notice-sales-tools-crm-embed-changes-nov-2020-feb-2021
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l Blank emails will not contain any headers or footers. So this means that unsubscribe links are

not included in these emails.

l In terms of reporting on blank emails in Insight, the emails appear in reports as Tracked Emails.

You cannot report on the subject line of a blank email.

¤Tip: If you disable this feature, you can create a blank email template for sales

which would give them control over their email but allows you to ensure headers,

footers, and unsubscribe links are included.

Using Engage

Use Engage to send personal email messages or email based on templates created in

Oracle Eloqua. Customize your email by adding images, attachments, hyperlinks, and so

on.

Sending personal email messages

You can compose an Engage email without a template. These are called blank emails

and allow you to email Oracle Eloqua contacts in a highly personalized way, while

maintaining Eloqua activity tracking.

Before you begin

l You can only use blank emails if allowed by your administrator. Learn more about Engage app

settings.

l Blank emails do not include Default headers and footers or an email group. If you want to

ensure you include headers and footers, send email using a template created in Oracle Eloqua.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/EmailGroups/Tasks/CreatingEmailGroups.htm#settings
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l Blank emails are sent using your default email signature. Learn more about setting up your

signature.

l The steps below reflect accessing Engage directly. Your administrator determines how you

access Engage which could be directly from your CRM. Learn more.

To send a personal email using Engage:

1. Open Engage.

2. Click Compose.

3. Select Blank Email, then click Choose. If you created a signature, it will automatically appear

on the blank canvas.

4. Create your email. Use the rich text options (bold, italic, underline, numbering, bullets,

indentation, as well as font style, size, and color) to customize your content. You can also insert

hyperlinks, images, attachments, signatures, and field merges.
5.
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Enter the email recipients in the To line.

l You can manually enter your recipients' email addresses or copy and paste contacts from Microsoft

Outlook, as well as XLS and CSV files.

ëNote: When you include multiple people in an Engage send, each person receives the email

individually and will not be aware of other recipients. This enables Eloqua to track each

recipient's engagement with the email.

l As you enter an email recipient's name or email address, Engage tries to validate the address:

A recipient highlighted in yellow indicates the contact doesn't

exist in the Eloqua database or is missing field merge values.

You will be prompted to create or update the contact when you

send the message. Your administrator may not allow you to

create or update contacts, and in this case, you must remove

the recipient.
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A recipient highlighted in red indicates the contact is globally

unsubscribed. You must remove the contact. Learn more.

A recipient highlighted in blue indicates the contact can be

sent the message. Further validations though will happen

when you send the message.

6. Enter the email subject.

7. Preview your email.

8. (Optional) Save your email.

9. When you're ready to send your email, click Send and resolve any issues.

After clicking Send, Eloqua checks for new contacts, contacts with missing field merges, and

whether the contact can be emailed based on the contact's group subscription status and the

email frequency settings specified by your administrator.

l Any contacts that don't exist in the Oracle Eloqua contact database appear yellow. When you send

the message, the Create Contact popup appears. If you can create contacts, complete as much detail

as you can about the new contact. Otherwise, you must remove the contact.

l If your email contains field merges, and the contact is missing field values, the fields also appear on

the Create Contact popup for you to complete for each contact. If your administrator allows you to

update contacts, you can complete the field merges. Otherwise, the default or a blank value will be

used if no default has been set.
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l You will be prompted to remove a contact if the contact is unsubscribed from the email group, is on

the master exclude list, or has reached the email frequency setting specified by your administrator.

These checks are not performed until you attempt to send the email. Learn more.

After you finish: 

l Once the email is sent, Engage displays your Recent Emails Sent history and send status.

l If you have issues with sending your message, learn more about troubleshooting Engage

issues.

Sending emails created in Oracle Eloqua

You can send emails from Engage by using a template created by your Oracle Eloqua

administrator. Learn about making email templates available in Engage.
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Before you begin:
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l The steps below reflect accessing Engage directly. Your administrator determines how you

access Engage which could be directly from your CRM. Learn more.

l Engage allows you to send emails to contacts in the Oracle Eloqua database. If permitted by

your administrator, you can create new contacts while composing your message.

l You can email a list of recipients by copying and pasting the list into your message. However,

each recipient will receive the message as if it was a personal message directly to them. They

will not be able to see the other recipients in their message. Your administrator determines the

maximum number of allowed recipients.

l You cannot schedule the sending of email from Engage.

To send an email created in Oracle Eloqua:

1. Open Engage.

2. Click Compose. The Select a Template page is displayed.

3. Select the template you want to use and click Choose.
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Tips for finding an email template

a. You can search for a template by name or subject line.

b. Use the tabs to help quickly find the template you are looking for:
l Recent: Displays any templates you recently viewed. This is the default tab. The first template is Blank

Email, if this permission has been enabled in Engage Global Settings. Select this to create your own

personal email in Engage without using a template.

l My: Displays templates created by you. By default, the newest templates are listed first. Click the refine icon

to sort alphabetically and to filter by an email group.

l All: Displays all available templates. By default, the newest templates are listed first. Click the refine icon

to sort alphabetically and to filter by an email group.

c. You can filter templates in My and All tabs based on an email group and sort them. Click the refine

icon to select the desired email group or sort templates alphabetically or by most recent. You can

combine the email group filter and search to narrow down your list of templates. To clear the filter,

select All in the email group drop-down or remove the email group label.
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4. After choosing a template, you can go back and select a different template by clicking the folder

icon again. Selecting a different email overrides any change you have made.

5. Edit your email content. Where permitted, you can edit email content by using the rich text

options (bold, italic, underline, numbering, bullets, indentation, as well as font style, size, and

color). You can also modify or insert hyperlinks, images, attachments, signatures, and field

merges.

l Content you can change is outlined in green and marked with an edit icon. Content you cannot

change is locked. Locked content is outlined in gray, is marked with a lock icon, and is locked based

on the configuration of the template.
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l Field merges can be easily identified. They are highlighted in yellow throughout your email, including

the Subject line. If needed, you can delete merged fields from the Subject line. If field merges in the
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body of the email template are protected, you cannot edit them. The values of these fields are

displayed when you preview your email.

6. Enter the email recipients in the To line.

l You can manually enter your recipients' email addresses or copy and paste contacts from Microsoft

Outlook, as well as XLS and CSV files.
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ëNote: When you include multiple people in an Engage send, each person receives the email

individually and will not be aware of other recipients. This enables Eloqua to track each

recipient's engagement with the email.

l As you enter an email recipient's name or email address, Engage tries to validate the address:

A recipient highlighted in yellow indicates the contact doesn't

exist in the Eloqua database or is missing field merge values.

You will be prompted to create or update the contact when you

send the message. Your administrator may not allow you to

create or update contacts, and in this case, you must remove

the recipient.

A recipient highlighted in red indicates the contact is globally

unsubscribed. You must remove the contact. Learn more.

A recipient highlighted in blue indicates the contact can be

sent the message. Further validations though will happen

when you send the message.

7. Modify the email subject.

l The email Subject line is pre-populated based on the template you selected. It can be modified.

l Merged fields or dynamic content pre-populated in the Subject line cannot be modified but can be

deleted.

l The email subject is replaced if you select a different template.

8. Preview your email. To return to the email, click Edit.

9. At this point, you can choose to save the message as a new template. Learn more.

10. When you're ready to send your email, click Send and resolve any issues.

After clicking Send, Eloqua checks for new contacts, contacts with missing field merges, and

whether the contact can be emailed based on the contact's group subscription status and the

email frequency settings specified by your administrator.
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l Any contacts that don't exist in the Oracle Eloqua contact database appear yellow. When you send

the message, the Create Contact popup appears. If you can create contacts, complete as much detail

as you can about the new contact. Otherwise, you must remove the contact.

l If your email contains field merges, and the contact is missing field values, the fields also appear on

the Create Contact popup for you to complete for each contact. If your administrator allows you to

update contacts, you can complete the field merges. Otherwise, the default or a blank value will be

used if no default has been set.

l You will be prompted to remove a contact if the contact is unsubscribed from the email group, is on

the master exclude list, or has reached the email frequency setting specified by your administrator.

These checks are not performed until you attempt to send the email. Learn more.

After you finish: 

l Delete duplicate or unnecessary email templates by clicking the icon and selecting Delete.

You must have appropriate asset permissions to delete email templates.
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l Once the email is sent, Engage displays your Recent Emails Sent history and send status.

l From the template chooser, you can delete templates by clicking the icon and selecting

Delete. You must have appropriate asset permissions to delete email templates.

l If you have issues with sending your message, learn more about troubleshooting Engage

issues.

Making a template available in Engage

You can create email templates that sales users can access and send in Engage. Sales

users are given access to email groups, and any email assigned to the email group will be

accessible as a template in Engage.

Before you begin:

l Verify and adjust permissions. To use the template, Engage users must have access to the

email group and View asset permissions. Engage also requires View permissions for any

landing page, form, or assets used in form processing steps such as custom objects.

l Enable customized content. Administrators can allow the sales user to: create emails without

templates, create their own templates, and add content to the email such as images,

attachments and field merges (contact field merges only). For more information, see

Configuring Engage.

l Test the template. Microsoft Outlook renders the email differently than the Eloqua email editor.

If your sales team uses Oracle Eloqua Sales Tools for Microsoft Outlook, test your email

template using the add-in. The following email editor features are not supported in the Microsoft

Outlook add-in: Locked Blocks, Hide in Mobile, protected email templates. Be sure to test your

template before providing it to Engage users.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=ContentBlocksOverview
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=HideInMobile
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l Consider protected templates. To prevent users from changing parts of the email message,

create a protected marketing email template. Protected email templates are not supported in

the Microsoft Outlook add-in.

l Contacts can only be sent messages using the template if they have subscribed to the

template's email group. This group subscription check happens after the Engage user clicks

Send to send the message.

l Consider only using a field merge if there is a default value for it. If the Engage message

recipient doesn't have a value for the field merge, the Engage user is always prompted to

update the contact record with missing values. Only if your Eloqua administrator has allowed

Engage users to update contact records, will they be able to add a value for the field. Engage

users can still send the message with no value, but this may mean your message doesn't read

as you want it to.

To make a template available in Engage:

1. Create and configure your email group and make it available to Engage.

a. Navigate to Assets > Email Setup > Email Groups.

b. Select an existing email group or create an new one.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailGroups
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c. Select the Make this Email Group available in Eloqua for Sales check box.

d. Click Permissions and review and customize the email group permissions. You want to ensure that

your sales users have access to the email group. Also ensure that your security group has access.

e. Save your changes.

2. Add your email template to the email group associated with Engage.

a. Navigate to Assets > Emails.

b. Select an existing email or create a new one.

¤Tip: You can create an Engage protected email template for your sales users by creating
your email from a protected marketing email template.

c. Ensure that you assign the email to the email group that you enabled for sales above. Contacts can

only be sent messages using the template if they have subscribed to the template's email group. This

group subscription check happens after the Engage user clicks Send to send the message.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=CreatingNewEmailsDesign
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=DefiningEditableElementsDesignEditor
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3. Review and customize the email permissions.

a. Click Actions, then select Permissions.

b. Ensure that your sales users have access to the email. The template will be available to sales users if

they have the View permission.

Creating an email signature

As an Engage user, you can create a personalized email signature that is automatically

inserted into your blank emails. If you select a template, the email signature is

overwritten.

To create an email signature in Engage:

1. Click Settings .

2. Select Include signature in blank emails.

3. Create your signature. Personalize it by using rich text options (bold, italic, underline,

numbering, bullets, indentation, as well as font style, size, and color).
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4. Click Save Settings.
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The email signature is created. The next time you create a personal email, the signature

will be added automatically.

Creating Engage templates

You can create a template in Engage so that you can reuse an email you've customized

or share new templates with other Engage users.

Before you begin:

l Marketing administrators must configure Engage to allow the creation of personal templates.

Learn more about Configuring Engage.

l You must have asset creation permissions to create new templates in Engage

l If you choose to share your template, it will be available to all Engage users based on the

selected Email Group

l Your template will also be available in Oracle Eloqua as a new email asset. You can find it in

this folder: engage-personal-folder-{userId}-{username}

To create an Engage template:

1. In Engage with your email open in the editor, click Save As or Save.

2. Modify the Name, Subject, and Email Group lines as needed. Select Share with other users if

you want other users to have access to this email.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/SecurityGroups/Tasks/ConfiguringAssetCreationSettings.htm#asset_creation
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¤Tip: Email groups determine default settings for the email such as headers and footers.
Groups are also used as a contact subscription option. When sharing templates, Engage

users with access to this Email Group will be able to access the email template.

3. Click Save. The email is saved in the email chooser in the root folder under a user-specific

folder: engage-personal-folder-{userId}-{username}. After you finish, you can also delete

duplicate or unnecessary email templates by selecting Delete. You must have appropriate

asset permissions to delete email templates.

Adding hyperlinks to Engage emails

You can insert hyperlinks in your Engage emails. A hyperlink can route your clients to a

landing page, a file, a web page, a system action, or a pre-addressed email that they can

fill out and send. You can also modify existing hyperlinks in your emails, as long as the

content is not locked.

Hyperlinks in your Engage emails are automatically tracked. Clicking the hyperlink during

preview or while viewing the sent history will not add to your tracking data. Learn more

about link tracking.

To add a hyperlink to an email:

1. Create a new Engage email or open an Eloqua email template.

2. Select the text that you want to use as a hyperlink, then click Hyperlink in the toolbar. If you

do not select text, the hyperlink will be inserted where your cursor is placed.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=OutboundLinkTracking
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3. Enter the URL you want to route your recipients to. You can also modify the text you want the

recipient to see.
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4. Click OK to save your changes. The OK button is enabled once text is entered in the URL field.

You can edit the text or URL of your hyperlink at any time by clicking it. Selecting Remove

only deletes the URL; the text remains in your email. If you select multiple hyperlinks in

your email and click Hyperlink , only the first hyperlink will be modified.

Adding images to Engage emails

You can insert images from your Oracle Eloqua image library or your device into your

Engage emails. You can also add hyperlinks to new and existing images.

Images uploaded from your device are saved in the root folder in Oracle Eloqua's image

library under a user-specific Engage folder: engage-personal-folder-{userId}-{username}.

Prerequisites

l Administrators must enable the insertion of images in Engage emails in Engage Global Settings

(Settings > Apps, under the Platform Extensions section). Learn more about configuring

Engage Global Settings.

l Images in Oracle Eloqua must have appropriate asset permissions in order to be available in

Engage. Administrators can manage this setting using security groups by enabling image view

and edit asset permissions. Learn more about default asset permissions.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=defaultassetpermissions
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l Images must be appropriately sized before inserting into your message.

l Accepted image file formats include GIF, JPG, JPEG, and PNG.

ZImportant: Always preview your email before sending it to your recipients to

ensure the layout and size of your images is as expected. You may need to resize

your images in the email Design Editor before inserting them into your Engage

email. Learn more about emails and working with email content and layouts.

To add an image to an email:

1. Create a new Engage email or open an Oracle Eloqua email template.

2. Place your cursor at the position in your email where you want the image to appear. It can be

moved later if desired. Click the Image icon in the toolbar.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/Emails/Emails.htm
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/EmailEditing/Tasks/WorkingWithContentAndLayouts.htm
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3. Select an image from the Oracle Eloqua image library or click Upload to browse your local

device.

For image uploads, the following file types are supported: GIF, JPG, JPEG, and PNG. The

maximum file size is 5 MB. You have the option to rename the image.

4. Click Choose. The image appears in your email.
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5. (Optional) Add a hyperlink to your image.

a. Click the image.

b. Enter the URL.

c. Click OK. The OK button is only enabled once text is entered in the URL field.

Adding attachments to Engage emails

You can insert attachments from your Oracle Eloqua File Storage library or device into

your Engage emails. This allows you to send relevant information such as white papers,

event invitations, and so on, to your contacts to drive higher engagement.

Attachments can be uploaded to a user specific Engage folder: engage-personal-folder-

{userId}-{username} located in the root folder of Oracle Eloqua’s File Storage library

(Assets —> Components —> File Storage).

Prerequisites:

l Administrators must enable the insertion of attachments in Engage emails in Engage Global

Settings (Settings > Apps, under the Platform Extensions section). Learn more about

configuring Engage Global Settings.

l Files must have appropriate asset permissions in order to be available in Engage.

Administrators can manage this setting using security groups by enabling image view and edit

asset permissions. Learn more about default asset permissions.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=FileStorage
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=defaultassetpermissions
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To add an attachment to an email:

1. Create a new Engage email or open an Oracle Eloqua email template.

2. Click the Attachment icon in the toolbar.

3. Select a file from the Eloqua File Storage library or click Upload to browse your files. You can

insert the file as a Tracked Link or Attached File.
l Use the Tracked Link option to add a tracked URL to the body of the email that points to the file hosted

in Oracle Eloqua’s File Storage Library. This allows clickthroughs to the file by the recipient of the

email to be tracked in Oracle Eloqua.

l Use the Attached File option to include the actual physical file in the email as a traditional attachment.

4. Click Choose. The attachment appears in your email.

Adding field merges to Engage emails

If you can create a blank email or edit the email template you are using, you can add

contact field merges to the email. For example, personalize your email with the recipient's
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name or company by using a field merge. When you send the email, Eloqua pulls in the

field merge data from the contact record.

To add a field merge to an email:

1. Create a new Engage email or open an Oracle Eloqua email template.

2. Click the Field Merge icon in the toolbar.
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3. Select a field merge. You can search by the field merge name to quickly find the field merge you

are looking for.

4. Click Choose. The field merge is inserted at your cursor’s location.

5. Click Preview to see how the fields will look when populated.

ZImportant: If a contact record contains field values that contain a default value,

such as First Name, the Create Contact popup will not be displayed when a user
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sends messages containing field merges. Field merges from such contacts can

cause incorrect values in email sent from Engage. Best practice is to populate all

fields for which you have accurate information and not allow default values for

commonly merged fields.

Adding signatures to Engage emails

You can insert signatures into your Engage emails. Signatures are created and stored in

your Oracle Eloqua component library in the Signature Layouts area. They can contain

images, field merges, and hyperlinks. Learn more about signature layouts.

ëNote: Email templates can include a signature with field merges and dynamic

content that is not editable. You can see how the signature will look when you

preview the message.

Prerequisites:

l Signature layouts in Oracle Eloqua must have appropriate asset permissions in order to be

available in Engage. Administrators can manage this setting using security groups by enabling

image view or edit asset permissions. Learn more about default asset permissions.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SignatureLayouts
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=defaultassetpermissions
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To add a signature to an email:

1. Create a new Engage email or open an Oracle Eloqua email template.

2. Place your cursor at the position in your email where you want the signature to appear. It can be

moved later if desired. Click the Signature icon in the toolbar.

3. Select a signature. You can search by the signature name to quickly find the one you are

looking for.
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4. Click Choose. The signature is inserted at your cursor's location.

Previewing Engage emails

The preview feature allows you to validate the email content prior to sending, which

saves time and helps maintain accurate reports compared to sending test emails to

yourself or colleagues. The preview displays the email that will be sent to the first

recipient and populates any necessary field merges (subject, body, signature), dynamic

content, cloud content, and so on. You can then click on any other recipient to preview

the message that will be sent to them and then return to editing if needed.

To preview an Engage email:
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1. Create a new personal Engage email, or use an Eloqua email as a template.

2. Edit the content as desired and permitted. Some email templates contain field merges, dynamic

fields, and other content that you cannot edit because it is protected. If the subject line is

populated with field merges and dynamic content, you cannot edit it but you can delete it and

enter a new subject line.

3. Enter the recipients and subject.

ëNote: The Preview button is enabled once the To and Subject fields are populated.

4. Click Preview. The preview displays the email that will be sent to the first recipient, populating

the field merges, dynamic fields, cloud content, and so on. You can then click the names of

additional recipients to preview how the message will be displayed to them.
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5. Click Edit in the preview screen to return to the Engage email and continue editing, or click

Send to send the email.

ëNote: The link tracking parameter is removed when you preview an email

message, disabling the tracking on all links within a preview.

Modifying the sent from email address

You can modify the email address that your Engage (and other Oracle Eloqua) emails will

be sent from.

ZImportant: This change will impact the from and the reply-to address when you

send emails in Eloqua.

To modify the sent from email address:

1. In Oracle Eloqua, click Settings .

2. Click Users in the Users and Security section.

3. Select the desired user or create a new one.

4. Expand General Info (Signature Fields).
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5. In the Email Reply-To Address field, enter the desired Reply-To address.

6. Click Save.

Troubleshooting Engage issues

When sending emails from Oracle Engage, it is possible that you encounter errors. Learn

about possible Engage send errors and how to resolve them.

Global unsubscribes

Problem

On the Engage compose screen, when adding an email address, an error appears

indicating the contact is globally unsubscribed.

Cause
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If a contact has unsubscribed from receiving all emails from your company, they are

known to be globally unsubscribed. You cannot email a globally unsubscribed contact.

Resolving this issue

Remove the contact from your email.

You could use Profiler to identify alternate methods to reach out to this contact.

Group unsubscribes

Problem

After clicking send, an error appears indicating the contact is unsubscribed from the email

group.

Cause

Contacts can unsubscribe from certain types of marketing emails identified by an email

group. For example, an email group can be included in your organization's subscription

center, allowing contacts to subscribe to the types of email they want to receive. To find

out if you are sending a particular email to a contact that is unsubscribed to an email

group, type their email address in the address bar and click send. When you click send, a

red banner on top of the address bar will appear alerting you that the recipient is

unsubscribed to an email group.

Resolving this issue

http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ProfilerData
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Since they have unsubscribed from that email group, you cannot send the email to them.

The goal of email group subscriptions is to make it easier for your contacts to identify

what they are interested in and keep them engaged with your organization. To avoid

global unsubscribes, it is important to respect a contacts preference.

To resolve this issue, you can change the email template or change to a blank email if this

has been enabled by your administrator.

Bouncebacks

Problem

After clicking send, an error appears indicating the contact's email address has bounced

back.

Cause

The contact's email address is incorrect or bad.

Resolving this issue

In this situation the email address is invalid and cannot be used. You will have to find an

alternate way of reaching out to them such as using their number. You could use Profiler

to identify alternate methods to reach out to this contact.

Master exclude list

Problem

http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ProfilerData
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After clicking send, an error appears indicating the contact is on the master exclude list.

Cause

In Eloqua, there are some domains of specific organizations that you cannot send email

to at all. For example, the master exclude list might include your competitors email

domain.

Resolving this issue

You cannot resolve this, and you must remove the contact from the email. Use Profiler to

identify alternate contact methods.

Recipient limits

Problem

After adding multiple email addresses to a message, an error indicates the maximum

recipients has been reached.

You can also receive a browser "414 Request - URI Too Large" error if you add a large

number of recipients directly using the browser address bar.

http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ProfilerData
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Cause

Your administrator can configure how many recipients you can add to an email. Learn

more about Engage app settings.

Resolving this issue

To work around this issue, break up the email and send it in smaller chunks.

Send limits

Problem

After sending an email, an error indicates the maximum recipients has been reached.

Cause

Send limits occur when you reach the maximum number of emails that you can send to

the same contact in a given period of time. The send limit is configured by your

administrator. In this case, after you click send, the error message indicates a send limit

being reached.

Resolving this issue

If you have reached the send limit, you will have to wait for the days within the send limit

to email the contact. For example, if your admin set the limit to 2 emails in 7 days, Eloqua

http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ConfiguringEngage
http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ConfiguringEngage
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is looking back at the last 7 days to determine how many times the contact has been

emailed by an Engage user. In this scenario, you would not be able to email the contact

until there are less than 2 emails sent in the last 7 days.

ëNote: Engage will not be able to tell you how many days you will have to wait

before being able to send an email to that contact again. To find that out, reach out

to your administrator.

Emails with plus sign (+)

If the email address you enter has a plus (+) sign in it, the email address will automatically

be split into two. You will have to re-enter the email address to resolve.

Engage license error

Problem

When I try to turn on tracking using Oracle Eloqua Sales Tools for Microsoft Outlook, an

Engage license error appears:

Cause
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Your administrator has disabled the ability to use the Microsoft Outlook add-in. You are

still permitted to use Engage, but you must use the web version instead.

Solution

Speak to your administrator about accessing Engage using Microsoft Outlook, or other

ways your are to access Engage, or use a URL listed here instead.

Cannot save a contact

Problem

When attempting to create a contact, the contact won't save, and no error message is

displayed.

Cause

Your administrator determines whether you can create contacts or not. If your

administrator disabled this feature, you cannot create any new contacts.
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Solution

Remove the contact. Use Profiler to find other contacts at the same organization. You

can also reach out to the contact by not using Engage.

Viewing email sent history

Your email sent history display the sent status of your previous emails. It is displayed

when you log in to Engage and after you send an email.

To view email sent history:

1. Navigate to the Engage home page using one of the following methods:

l Logging in to Engage.

l
Click the Engage icon .

l Sending an email.

Engage displays a list of successfully sent emails along with their sent status, date, and number

of email opens and clicks.

l A green icon indicates the email was sent successfully to all recipients.

l An orange icon indicates the email was sent successfully to some recipients.

l A red icon indicates the email was not sent successfully to any recipients.

http://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ProfilerData


©2025 Oracle Corporation. All rights reserved 172 of 269

Click the Failed Email Sends button to view emails which did not send.

2. Select an email to view additional details. Explore the different tabs to learn more about your

sent email.
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l Emails tab: Displays a thumbnail image of your email.

l Sent tab: Displays the recipients of the email. If you have a Profiler license, you can click a recipient's

name to view additional details.

l Opens tab: Displays the recipients who opened the email. Learn more about how email opens are

calculated.

l Clicks tab: Displays the recipients who clicked a link in the email.

Engage reports

Engage reports provide insight about the performance of your sent emails.

Access reports by opening Engage and clicking Reports on the sent emails page or

directly at this URL: https://login.eloqua.com/apps/salesTools/engage/reports

There are two Engage report types available:

l Engage top templates report

l Engage emails by recipient report

¤Tip: Reports can be embedded in your CRM (similar to Engage and Profiler).

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Profiler
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=CalculatingEmailOpens
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=CalculatingEmailOpens
https://login.eloqua.com/apps/salesTools/engage/reports
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Engage top templates report

The Engage top templates report provides information about the performance of your

templates over a given period. You can reuse the templates that have the best

performance.

To access the top templates report:

1. Open Engage.

2. Click Reports on the sent emails page.

¤Tip: You can send an email using one of the templates in your report results. Click

the template name to load the email compose screen.

Report filters

The report displays emails sent by the logged-in user.
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Use the search and date picker to limit the number of templates displayed:

l Search by template name.

l Filter results by date sent. Use the standard time frames from the drop-down list or enter a

custom date by clicking the calendar icon. The default time frame is the Last Week.

Results are sorted by highest unique open rate by default. Use the Sort By drop-down list

to sort by a different metric.

Report metrics

This report captures the following metrics.

Metric Description
Unique open rate The unique opens divided by the total number of times an
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Metric Description
email was delivered. (Unique Opens / Total Delivered)

A unique open is the number of recipients (original recipients
or email forwards) that opened an email at least once. This
does not count all the times that the same recipient opened the
email.

Oracle Eloqua counts an email as opened if the recipient
loaded the tracking pixel image contained in the email or
clicked a link in the email. Learn more about how email opens
are calculated.

Click-to-open rate Clicked sends / opened sends. Both clicked sends and
opened sends ignore possible forwards.
Clicked sends: The first clickthrough by the original recipient.
This metric ignores possible forwards.
Opened sends: The number of first opens for the emails that
were sent. This metric ignores possible forwards.

Engage emails by recipient report

The Engage emails by recipient report provides information about who has opened and

clicked on the emails you have sent over a given period of time.

To access the emails by recipient report:

1. Open Engage.

2. Click Reports on the sent emails page.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=CalculatingEmailOpens
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=CalculatingEmailOpens
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3. Click the Top Templates drop-down and select Emails By Recipient.

¤Tip: You can select one or more recipients from this report and send a new email

to them. Select your recipients and click Compose. Then select your template and

create your email.

Report filters

The report displays a list of recipients for your sent emails. Emails sent to multiple

recipients are listed individually.

Use the date picker to limit the number of email recipients displayed. Use the list's

standard time frames or enter a custom date by clicking the calendar icon. The default

time frame is Last Week.
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Results are sorted starting with the most recently sent email by default. Use the Sort By

drop-down to sort by a different metric.

Report metrics

This report captures the following metrics.

Metric Description
Total opens The number of times an email was opened. This includes

multiple opens by the original recipient or forwarded recipient.

Oracle Eloqua counts an email as opened if the recipient

loaded the tracking pixel image contained in the email or

clicked a link in the email. For more information, see
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Metric Description

Calculating email opens.

Total clicks The total clickthroughs. This includes multiple clicks by the
same recipient. System Action links are not tracked.

Hard bouncebacks The total emails that returned a hard bounceback.

A hard bounce is an email that permanently could not be

delivered. Some common reasons for hard bounces include

an invalid email address or domain name.

Exporting Engage report results

The results from the Engage Top Templates and Emails By Recipient reports can be

exported to a Microsoft Excel (.xlsx) file.

To export Engage report results:

1. Open either the Top Templates or Emails By Recipient report.

2. Use filters to narrow your results. Only the results matching your filer criteria will be exported.

3. Click Export .

4. Open or Save the Microsoft Excel file to your machine.

ëNote: The Microsoft Excel export file is capped at 10,000 rows.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=CalculatingEmailOpens
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Engage integration

Engage can be embedded in several customer relationship management (CRM)

systems, including Oracle CRM onDemand and Salesforce. This integration makes it

easier and more convenient for you to access the sales tool from within your chosen

system.

Engage activities, including full emails, can be synched over to your CRM. The time it

takes for a new contact or template to appear in your CRM depends on the integration

rules setup between your Eloqua instance and your CRM.

You can access Engage via the CRM by embedding the login URL. If your CRM is

Salesforce, Engage also supports using Salesforce as an identity provider.

Embedding Engage as a subtab in Oracle Sales

ZImportant: Oracle Sales was formerly known as Oracle Sales Cloud. All instances

of Oracle Sales Cloud have been changed to Oracle Sales across the app user

interface.

To enrich the user experience when working in Oracle Sales, you can embed an Engage

subtab into standard objects, such as Contacts and Sales Leads. This way, you can allow

users to send emails with Engage without having to leave Oracle Sales.



©2025 Oracle Corporation. All rights reserved 185 of 269

Prerequisites:

l Build an allowlist of the domains that will be hosting embedded Engage pages. Learn more in

the Configuring Engage topic.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more. The steps below

assume you are using the simplified login URL.

There are five steps to creating an Engage subtab in Oracle Sales:

1. Creating a sandbox

2. Creating mashup content

3. Adding the mashup content to a standard object in Oracle Sales

4. Publishing your sandbox

Step 1: Creating a sandbox

To create a sandbox:
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1. Log in to Oracle Sales with your Administrator credentials.

2. Click Navigator at the top of the page, and under Configuration click Sandboxes.

3. Click Create Sandbox.

4. Ensure Application Composer is checked as Active, give your sandbox a name, and ensure

that Publishable is set to Yes.

5. Click Create and Enter.

You'll be redirected to the Available Sandboxes page.

Step 2: Creating mashup content

To create mashup content:
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1. At the top of the page, click Tools > Application Composer.

2. In the Overview section, click Mashup Content > Register Web Application. Alternatively, you

can click Mashup Content in the left-side panel under Common Setup.

3. Configure the following options:

l Give your web application a name. For example, Eloqua Engage.

l Select Groovy expression.

4. Click Save and Close.
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Step 3: Adding the mashup content to a standard object

To add the mashup content to a Contact or Sales Lead object:

1. Still in the Application Composer, navigate to the left-side panel under Objects, expand

Standard Objects, then expand the object you would like to add your subtab to.

In this topic, we'll expand the Sales Lead object.
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2. Click Pages.

3. In the Application Pages tab, scroll down to the Details Page Layouts section, and click Default

Custom Layout.

ëNote: If you do not see the Default Custom Layout you can add it by duplicating an

existing layout. For example, duplicate the Standard layout, then edit the duplicate

layout.
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4. Scroll down and click Add .

5. Select Mashup Content, then click Next.

6. Select your Mashup Content from the Web Applications list, then click Insert.

7. Configure the following options:

l Give your subtab a name. In this case, you would give it a name related to Engage. For example, you

could name the subtab Eloqua Engage.

l (Optional) Click Change Icon to change your subtab's Display Icon.

8. In the Edit Script area, insert the following script:

if (PrimaryContactEmailAddress != null) {

return "https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose?emailAddress="

+ PrimaryContactEmailAddress;

}

else {

return "https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose";
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}

¤Tip: If you're adding Profiler to the Contacts object, replace
PrimaryContactEmailAddress in the above code samples with

PrimaryEmailAddress. Since in this topic we're adding Profiler to the Sales Leads

object, we'll keep PrimaryContactEmailAddress in our code.

9. (Optional) Click Next. The Next option only appears if there are other details page layouts

available to add the subtab to.

10. Click Save and Close.

11. Done.

Step 5: Publishing your sandbox

1. Click Sandboxes, then click on your sandbox's name.

2. Click Publish.

After following these steps for Engage, you can now view the subtab when you navigate to the

standard object's page. For example, since in this topic we created a subtab for the Sales Lead

object, we'll navigate to Navigator > Leads under Sales. Once you open a lead, you see the

Engage subtab.
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Troubleshooting

l For Firefox users, if you’re using Autologin or SAML access methods, and you cannot progress

past the Eloqua authenticate now login screen, you may have to disable Firefox enhance

tracking protection. To do this, in Firefox, navigate to Options in the Firefox browser > Privacy

& Security > Enhanced Tracking Protection > select Custom > uncheck the box for Cookies.

l If you see a content security policy directive message in the iframe, check that your Engage

allowlist includes the required URLs for embedding in Oracle Sales. Make sure to also confirm

that the URL you are using is correct.

Adding an Engage link to Oracle Sales

There are two main steps that you must follow to add an Engage link to your Oracle Sales

(formerly Oracle Sales Cloud) account:
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1. Create an Engage link

2. Add the Engage link to a layout

Step 1: Creating an Engage link

To create an Engage link:

1. Login with your Administrator credentials.

2. Click the Navigator icon, then under Tools click Customization > Application Composer.

3. In the left-side pane, select Marketing from the Application drop-down list.

4. Expand Objects > Standard Objects > Sales Lead Contacts, then select Actions and Links.

5. Click Create to create a link, then enter the following information:

l Display Label: Engage

l Name: Eloqua_Engage

l Type: Select Link

l URL Definition: Enter the simplified login URL:

def eURL="https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose"

To use the legacy URLs, replace the eURL value above with the Legacy login URLs
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6. Customize the Engage URL with parameters that support the desired experience for your sales

users. Learn more.

¤Tip: To pass the email address of the contact, use the following updated URL def
eURL="https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose?sendTemp

lateToContacts/" + nvl(PersonEmail,"no email".

7. Click Validate to validate the script.

8. Click Save.

Step 2: Adding the Engage link to layouts

To add the Engage link to a layout:

1. In the Application Composer left-side menu, locate the object used in Step 1 of this document,

then click Pages.

2. Under the Details Page Layouts section, select the layout to which you want to add the link,

then click Edit .

3. Click the Edit icon next to the Contact Overview Form.

4. Under the Available Fields column, select the Engage link that you created then click the

arrow to move the link to the Selected Fields column.

5. Adjust the link's location on the list using the up and down arrows next to the list, then click

Save and Close.
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Add Engage to Oracle Sales Redwood User Experience

To add Oracle Eloqua Engage in Oracle Sales in the Redwood User Experience, you can

create custom smart actions that navigate users to Eloqua Engage.

There are three steps to launching Engage in Oracle Sales Redwood User Experience:

1. Create a sandbox

2. Create a smart action

3. Publish a sandbox

Step 1: Create a Sandbox

1. Log in to Oracle Sales with your Administrator credentials.

2. Click Navigator at the top of the page, and under Configuration click Sandboxes.

3. Click Create Sandbox.

4. Ensure Application Composer is checked as Active, give your sandbox a name, and ensure

that Publishable is set to Yes.

5. Click Create and Enter.

You'll be redirected to the Available Sandboxes page.

Step 2: Create a smart action

1. In Application Composer, click Smart Actions, available under Common Setup.

2. On the Smart Actions page, click Create. Application Composer displays the Create Smart

Action guided process in a new browser tab.

3. On the Kind of Action page:

a. Click UI-based action.

b. Click Continue.
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4. On the Basic Details page:

a. In the Name field, enter a display name Eloqua Engage for the action

b. In the Object field, select the Contact object for which you're creating the action. If you are embedding

Engage for Leads, then select the Sales Lead object

c. In the Action ID field, accept the automatically generated value or enter a unique value. This value

must be unique across all smart actions

d. Click Continue.

5. On the Availability page:

a. In the Application field, select the Sales application where the action will display

b. In the UI Availability field, select the List Page where the action will display in addition to the Action

Bar

c. Optional - In the Role Filter field, optionally select the custom roles that can view the action. (If you

don't select a role, then the action will be available to all roles). For details see Create UI-Based Smart

Actions

d. Optional - In the Condition region, optionally set conditions for the action to appear, such as only if a

certain field's value is set to a particular value. For example, show a smart action only if a lead's status

is Hot. For details see Create UI-Based Smart Actions.

6. On the Action Type Page:

a. In the Type field, specify the type of action, Navigate to URL.

b. In the URL field, insert the following URL:

https://login.eloqua.com/siteLogin?SiteName=

{EloquaCompanyName}&ReturnUrl=/apps/salesTools/engage/compose?emailAddress=${EmailAdd

ress}

c. If you are adding Eloqua Engage to Contacts:

In the Value column for EmailAddress in the Field Mapping section, select Email (EmailAddress)

d. If you are adding Eloqua Engage to Sales Leads:

https://docs.oracle.com/en/cloud/saas/applications-common/25a/oacex/create-ui-based-smart-actions.html
https://docs.oracle.com/en/cloud/saas/applications-common/25a/oacex/create-ui-based-smart-actions.html
https://docs.oracle.com/en/cloud/saas/applications-common/25a/oacex/create-ui-based-smart-actions.html
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In the Value column for EmailAddress in the Field Mapping section, select ContactEmail

(PrimaryContactEmailAddress).

e. In the Browser Window Target field, specify New tab.

7. On the Action Details page, leave it blank and click Continue.

8. On the Confirmation Message page, leave it blank and click Continue.

9. On the Review and Submit page, review the action's configuration and click Submit when

ready.

Step 3: Publish a Sandbox

1. Click Sandboxes, then click on your sandbox's name.

2. Click Publish.

After following these steps for Engage, you will now be able to see Engage from the

object list in the action drop down menu. For example, if you we created a Smart Action

for the Sales Lead object, then you will be able to see Engage for a Sales Lead from the

action menu when a specific lead is selected.

After Completion, you should find the smart Action available for selection.

Additionally the Smart Actions would be available to launch from a contact record.
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Embedding Engage as a tab or button in Salesforce Classic

ëNote: If you are using Salesforce Lighting, see Embedding Engage as a tab or

button in Salesforce Lightning.

This section will walk you through making Engage seamlessly available to Sales users

inside Salesforce.

There are two ways Engage can be deployed within Salesforce Classic:

l As a top navigational tab

l As a button on the Lead and Contact Page layouts

Embedding Engage as a tab in Salesforce Classic

Prerequisites:

l Build an allowlist of the domains that will be hosting embedded Engage pages. Learn more in

the Configuring Engage topic.
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l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more.

To embed Engage as a tab in Salesforce Classic:

1. Log in to Salesforce.

2. Navigate to Setup and search for Tabs.

3. Under the Web Tabs section for your Salesforce, click New.

4. Click Next through the default tab settings.

ëNote: Engage is responsive and can work within any layout. Additionally, you may want
to set the height of your tab to more than 800px to better accommodate the reporting

available to users in Engage.

5. Once you are at Step 3: Enter the URL Details, in the Button or Link URL section input one of

the following URLs based on your preferred configuration:

l Simplified login URL: https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose

l To use the legacy URLs, see Legacy login URLs

6. Save your changes. You should now be able to click on the Engage tab and be logged in

seamlessly to Engage.
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Embedding Engage as buttons on Salesforce Lead and Contact page layouts

There can be multiple Engage buttons on the Lead/Contact page layout within

Salesforce. The following steps will walk you through modifying the two most common

buttons.

Prerequisites:

l Build an allowlist of the domains that will be hosting embedded Engage pages. Learn more in

the Configuring Engage topic.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more.
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To embed Engage as buttons on Salesforce Lead and Contact Page layouts:

1. Log in to Salesforce.

2. Navigate to Setup > Customize (under Build section) > Leads > Buttons, Links, and Actions.

3. Click New Button or Link to start with a fresh button.

4. Set up your button:

a. Label and name the button something unique and easy to recognize.

b. Under Display Type, select Detail Page Button.

c. For Behavior, select whether you want this button to launch Engage in an existing or new window and

with or without the sidebar.

d. In the main box, enter one of the following URLs, depending on your login method:
l Simplified login URL: https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose

l To use the legacy URLs, see Legacy login URLs.

e. Customize the Engage URL with parameters that support the desired experience for your sales users.

Learn more.

¤Tip: To pass the email address of the lead, add the following parameter to the URL
emailAddress={!lead.email}. For contact object, use emailAddress=

{!contact.email}.
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5. Save all the changes to your buttons and test by loading a Lead/Contact. On a Lead/Contact

record, clicking these Engage buttons should give seamless access to Engage. Ensure you are

logged into Salesforce from your dedicated Salesforce domain and not the standard

login.salesforce.com.

ëNote: Creating a New Button instead of modifying an existing one requires you to

add that button to the page layout used by your organization. To do this, navigate to

Setup > Customize (under Build section) > Leads (or Contacts) > Page Layouts.
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Add the button to the page layout, then select Buttons in the list. Drag the New

Button to the designated Custom Buttons area in the layout, then click Save.

Embedding Engage as a tab or button in Salesforce Lightning

ëNote: If you are using Salesforce Classic, see Embedding Engage as a tab or

button in Salesforce Classic.

This section will walk you through making Engage seamlessly available to Sales users

inside Salesforce.

There are two ways Engage can be deployed within Salesforce:

l As a top navigational tab

l As a button on the Lead and Contact Page layouts

Embedding Engage as a tab in Salesforce Lightning

Prerequisites:

l Build an allowlist of the domains that will be hosting embedded Engage pages. Learn more in

the Configuring Engage topic.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more. In this topic, we refer

to the simplified login only.
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To embed Engage as a tab in Salesforce Lightning:

1. Log in to Salesforce.

2. Navigate to Setup.

3. Locate the Quick Find search box, and search for Tabs

Alternatively, you can click User Interface > Tabs.

4. Under the Web Tabs section for your Salesforce, click New.

5. Click Next through the default tab settings.

ëNote: Engage is responsive and can work within any layout. Additionally, you may want
to set the height of your tab to more than 800px to better accommodate the reporting

available to users in Engage.

6. Once you are at Step 3: Enter the URL Details, in the Button or Link URL section input one of

the following URLs based on your preferred configuration :

l Simplified login URL: https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose

l To use the legacy URLs, see Legacy login URLs. 

7. Save your changes. You should now be able to click on the Engage tab and be logged in

seamlessly to Engage. Ensure you are logged in to Salesforce from your dedicated Salesforce

domain and not the standard login.salesforce.com.

Embedding Engage as buttons on Salesforce Lead and Contact Page layouts

There can be multiple Engage buttons on the Lead/Contact page layout within

Salesforce. The following steps will walk you through modifying the two most common

buttons.
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Prerequisites:

l Build an allowlist of the domains that will be hosting embedded Engage pages. Learn more in

the Configuring Engage topic.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more.

To embed Engage as buttons on Salesforce Lead and Contact Page layouts:

1. Log in to Salesforce.

2. Navigate to Setup.

3. Locate the Quick Find search box, and search for Object Manager.

Alternatively, you can click Objects and Fields > Object Manager.

4. Click the object you want to edit (for example a Contact or Lead).

5. Click Buttons, Links, and Actions.

6. Click the New Button or Link.

7. Alternatively, you can find one of the buttons you created for Engage and click to edit. You most

likely have multiple Engage buttons on the Lead/Contact objects. Each button can be used to

either open a desired template, email specific recipients, and so on. Alternatively, you can click

New Button or Link to start with a fresh button. Set up your button:

a. Label and name the button something unique and easy to recognize.

b. Under Display Type, select Detail Page Button.

c. For Behavior, select whether you want this button to launch Engage in an existing or new window and

with or without the sidebar.
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d. In the main box, enter one of the following URLs, depending on your login method:
l Simplified login URL: https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose

l To use the legacy URLs, see Legacy login URLs.

e. Customize the Engage URL with parameters that support the desired experience for your sales users.

Learn more.

¤Tip: To pass the email address of the lead to Engage, add the following parameter to the
URL emailAddress={!lead.email}. For contact object, use emailAddress=

{!contact.email}.

8. Save all the changes to your buttons and test by loading a Lead/Contact. On a Lead/Contact

record, clicking these Engage buttons should give seamless access to Engage. Ensure you are

logged into Salesforce from your dedicated Salesforce domain and not the standard

login.salesforce.com.

To add custom buttons on the Salesforce Lead and Contact Page layouts:

1. While still editing your object, click Page Layouts.

2. Choose the appropriate layout.

3. Click Mobile & Lightning Actions.

ëNote: Use Mobile & Lightning Actions to locate your button. Do not use Buttons, which

is intended for Salesforce Classic.
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4. Drag your button into one of the sections, such as Salesforce Mobile and Lighting Experience

Actions.

5. Reorder the location of your button based on your needs.

Your button should now display in the record you edited.

Embedding Engage in Microsoft Dynamics 2013

You can embed Engage in Microsoft Dynamics 2013.

Prerequisites:
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l Build an allowlist of the domains that will be hosting embedded Engage pages. Learn more in

the Configuring Engage topic.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more.

To install Engage in Dynamics 2013:

1. Navigate to Settings > Customization > Customizations > Customize the System.

2. Select Entities > Contact > Forms.

3. Double-click the form you want to add Engage to, such as Main.

4. Click Insert in the top menu.

5. Add a One Column Tab. Name it whatever you like.

6. Add an IFRAME to this tab.

a. Name: IFRAME_Engage

b. URL: http://about:blank

c. Label: Eloqua Engage

d. Ensure that Restrict cross-frame scripting is unchecked

7. Select the Formatting tab. Modify the height by setting the number of rows (try 20).

8. Select the Dependencies tab. Add email as a dependent field.

9. Click OK to close the IFRAME window.
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10. On the Form model, click Form Properties.

11. Click the Events tab.

12. In the Form Libraries section, click Add and then click New.

a. Name: new_EPPOnLoad

b. Type: Script (JScript)

c. Click Save and Close

13. Now double-click on the newly created Form Library new_EPPOnLoad.

14. In the Text Editor copy and paste one of the following code snippets (depending on your login

choice).

l Simplified login URL

var newUrl = "https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose

Xrm.Page.ui.controls.get("IFRAME_Engage").setSrc(newUrl);

l To use the legacy URLs, replace the newURL in the code above with the Legacy login URLs.

15. Customize the Engage URL with parameters that support the desired experience for your sales

users. Learn more.

¤Tip: To pass the email address of the contact or lead add the following parameter to the
URL emailAddress="+ document.getElementById("{emailaddress1}").title;.

16. Click Save and click on the newly created library.

17. Click OK
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18. Click Save

19. Click Publish.

20. Repeat for the Leads entity, if desired.

Embedding Engage in Microsoft Dynamics 365

You can add Engage to your Microsoft Dynamics 365 instance.

Prerequisites

l A Microsoft Dynamics 365 instance and the permissions needed to customize it

l Build an allowlist of the domains that will be hosting embedded Engage pages. Learn more in

the Configuring Engage topic.
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l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more.

To install Engage in Microsoft Dynamics 365:

1. Log in to Microsoft Dynamics 365 and navigate to Settings.

2. In the Customization section, click Customizations.

3. On the Customization page, click Customize the System.

4. On the PowerApps page, under Components, select Entities > Contact > Forms.
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5. Click New, then select the form you want to add Engage to, such as Main Form.

6. Click the Insert tab.

7. Add a One Column Tab select the new tab and click IFRAME to add an iframe to it.

The Add an IFRAME window is displayed.
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8. Enter the following iframe values.

a. Name: IFRAME_Engage

b. URL: http://about:blank

c. Label: Eloqua Engage

d. In the Security section, clear the Restrict cross-frame scripting option.
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9. (Recommended) In the Row Layout section of the Formatting tab, increase the height by setting

the number of rows to 20 so that Engage will have enough room to display its information.

10. On the Dependencies tab, add email as a dependent field.

11. Click OK to close the Add an IFRAME window.

12. On the Home tab, click Form Properties.

The Events tab of the Form Properties window is displayed.

13. In the Form Libraries section, click Add. The Lookup Record window is displayed.

14. Select new_EPPOnLoad and click Add.
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15. In the Event Handlers section of the Form Properties window, click Add.

The Handler Properties window is displayed.
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16. From the Library list, select new_EPPOnLoad.

17. In the Function box, enter loadEngage, click OK, and then click OK to close the Form

Properties window.

18. Double-click your new iframe. The IFRAME Properties window is displayed.

19. Click the Events tab, expand Form Libraries, and double-click new_EPPOnLoad. The Edit

Content window is displayed.

20. Depending on your login type, copy and paste one of the following code snippets into the code

editor:

l Simplified login URL

function loadEngage() {

var newUrl = "https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose

Xrm.Page.ui.controls.get("IFRAME_Engage").setSrc(newUrl);
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}

l To use the legacy URLs, replace the newURL in the code above with the Legacy login URLs.

21. Customize the Engage URL with parameters that support the desired experience for your sales

users. Learn more.

¤
Tip: To pass the email address of the contact or lead add the following parameter to the

URL emailAddress="+ document.getElementById("{emailaddress1}").title;

and replace {emailaddress1} with the value in your Microsoft Dynamics 365 instance.

For example, it can be emailaddress1, emailaddress1_d, or emailaddress1_i.

To determine what is used in your Microsoft Dynamics 365 data, inspect an existing

contact's email address with your browser's developer tools. For example, to find your

value using Google Chrome:

a. Go to Sales > Contacts and click an existing contact.

b. Pressing Ctrl+Shift+I to open developer tools.

c. On the Elements tab, press Ctrl+F and search for emailaddress1.

d. The value associated with the contact's email address field that is followed by title="

{emailAddress}" indicates the value you need to include. In the following example, the
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needed value is emailaddress1_d.

22. Click OK and then click OK to close the IFRAME Properties window.

23. On the Home tab, click Save, click Publish, and then close the PowerApps window.
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Embedding Engage in CRM onDemand

When embedding Engage in CRM onDemand, there are two main steps that you must

follow:

1. Create a web applet

2. Add the web applet to a page layout

ëNote: You will need to create two applets – one for leads and one for contacts.

The instructions below are for Contacts but you can follow the same procedure for

Leads.

Step 1: Creating a web applet for contact and leads

Prerequisites:

l Build an allowlist of the domains that will be hosting embedded Engage pages. Learn more in

the Configuring Engage topic.

l Determine the Oracle Eloqua login URL you want to use. You can use the simplified login URL

or a specific legacy URL based on the desired login method. Learn more.

To create a web applet:

1. Login to CRM onDemand with your Administrator credentials.

2. Navigate to User > Configure > Admin.
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3. Click Application Customization.

4. Under Record Type Setup, click Contact.

5. Under Pay Layout Management, click Contact Web Applet, then enter the information below:

l Name: Enter a name. ( Example: Contact Engage)

l Location: Select Detail Page

l Type: Select URL

l URL: Enter one of the following URLs

l Simplified login URL: hthttps://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose

l To use the legacy URLs, see Legacy login URLs

l Customize the Engage URL with parameters that support the desired experience for your sales users.

Learn more.

¤Tip: To pass the email address of the contact or lead, use
https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&Url=/apps/embed/salesTools/engage?compose&emailAddress%3D%%%Emai

l_Address%%%.

l Height: Enter 800
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6. Click Save.

Step 2: Adding webs applet to page layouts

To add an applet to a page layout

1. Navigate to User > Configure > Admin.

2. Click Application Customization.

3. Under Page Layout Management, click Contact Page Layout.

4. Choose the page layout that you want to modify

5. It is not necessary to configure Steps 2 or 3. Click Step 4 (Related Information) to continue.

6. In the Not Available Information column, locate the web applet that you created, then highlight it

(single left-click) and click the > arrow to move it to the Available Information column.

7. Select the applet in the Available Information column, then click the > arrow to move it to the

Displayed Information column.

8. Click Finish.
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ZImportant: Repeat the above steps for Leads

Embedding Engage in Okta with SSO

Learn how to access Engage if you are using Okta SSO.

Overview

The high-level configuration steps are as follows:

1. Setup Okta as an identity provider in Oracle Eloqua

2. If you are going to embed Engage pages in other apps, create the allowlist of domains that will

host Engage pages.

3. Understand how to access Profiler:

l Accessing Engage with Okta SSO

l Accessing Engage as an Okta app

Accessing Engage with Okta SSO

Engage is an app you can access via a URL from any location. It could be launched

standalone in a browser but is most commonly embedded inside a CRM system.

Before you begin:

l Setup Okta as an identity provider in Oracle Eloqua

SingleSignOn.htm
SingleSignOn.htm
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To access Engage Okta SSO:

1. Enter the following URL:

l To launch Engage standalone in a browser using the simplified login URL:

https://login.eloqua.com/siteLogin?SiteName=

{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose

l To embed Engage in a CRM or other app using the simplified login URL:
https://login.eloqua.com/siteLogin?SiteName=
{CompanyName}&ReturnUrl=/apps/embed/salesTools/engage/compose

l To use the legacy URLs, see Legacy login URLs.

Once you have this properly formatted URL, as long as a user has an Okta session active

in their browser, they can access Engage.

Accessing Engage as an Okta app

To allow users direct access to Engage from apps in Okta:

1. In Okta, create a new Okta app for Eloqua Engage.

2. While creating the SAML2 template, add the following to the Default Relay State field:

ReturnURL=%2Fapps%2FsalesTools%2Fengage

¤Tip: You can append additional parameters to this URL. For example, to open the
Engage compose page. Learn more.
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Oracle Eloqua Sales Tools for Google
Chrome

Oracle Eloqua Sales Tools for Google Chrome is an extension for Google Chrome. The

extension allows sales representatives to view contacts' profile information from Oracle

Eloqua, as well as email prospects more efficiently by displaying contact information from

Profiler in an easy to access pop-up in your browser. By using the extension, you no

longer need to open Profiler in a separate tab and manually search for contacts. You can

also access Engage to send emails to contacts.
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¤Tip: Please share your feedback by clicking Submit Feedback and let us know

how we can improve this app. If you require support, please log in to My Oracle

Support and create a service request.

https://support.oracle.com/
https://support.oracle.com/
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Oracle Eloqua Sales Tools for Google Chrome is able to:

1. Match to Eloqua contacts based on email addresses on a web page

2. Match to Eloqua contacts based on a domain

3. Match to Eloqua contacts based on a LinkedIn profile page

Installing Sales Tools for Google Chrome

Oracle Eloqua Sales Tools for Google Chrome is installed as a Chrome extension in your

browser.

ZImportant: Ensure that you have asset creation permissions for creating emails

and profile views.

Prerequisites

l A Profiler license is required. Some features of Sales Tools for Chrome may be used with

Engage, but Engage is not required for access.

l Profiler must be installed and configured in your Oracle Eloqua instance.

l Google Chrome web browser must be installed on your machine.

To install Oracle Eloqua Sales Tools for Google Chrome:

1. Navigate to the Oracle Eloqua Sales Tools extension page on the Google Chrome web store:

https://chrome.google.com/webstore/detail/oracle-eloqua-sales-

tools/jngjmljecflgeoiagcladdhcpalcdfpm

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/SecurityGroups/Tasks/ConfiguringAssetCreationSettings.htm#asset_creation
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Profiler
https://chrome.google.com/webstore/detail/oracle-eloqua-sales-tools/jngjmljecflgeoiagcladdhcpalcdfpm
https://chrome.google.com/webstore/detail/oracle-eloqua-sales-tools/jngjmljecflgeoiagcladdhcpalcdfpm
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or navigate to the Google Chrome web store

https://chrome.google.com/webstore/category/extensions and search for Oracle Eloqua Sales

Tools.

2. Click Add to Chrome.

3. In the confirmation pop-up, click Add extension.

Sales Tools for Google Chrome is now installed. The extension icon appears next to the

Chrome menu in your browser.

Accessing Sales Tools for Google Chrome

Oracle Eloqua Sales Tools for Google Chrome is accessed with your Oracle Eloqua

credentials.

l Sales Tools for Google Chrome must be installed.

ëNote: If you are already currently logged in to Oracle Eloqua, you do not need to

login to Oracle Eloqua Sales Tools for Google Chrome.

To access Oracle Eloqua Sales Tools for Google Chrome:

1. Click the Sales Tools for Google Chrome icon in Chrome.

2. Click Authenticate Now.

https://chrome.google.com/webstore/category/extensions
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3. Enter your Eloqua credentials and click Sign In.

ZImportant: If you are leveraging Single Sign On, click Use Another Account to sign in
with your company credentials. If you are unsure of how to complete the Company field,

please contact your administrator.

You are now logged into the Sales Tools for Google Chrome and can access contact

information from Profiler in the pop-up in your browser.

Matching to contacts based on email addresses on a web
page

When navigating to a web page with one or more email addresses, Oracle Eloqua Sales

Tools for Google Chrome displays those email addresses in a list. The Profiler icon is

displayed for any matching contacts inside Eloqua. Therefore, you can quickly view their

Profiler digital body language (contact details, activities, lead score value, and so on).

The extension also provides the option to email any users on the page using Engage.

Clicking the Engage icon next to a contact opens Engage in a separate tab, automatically

populating the To field. If there are multiple email addresses on the page, you have the

option to email all contacts.

ëNote: In order to use this feature, Search must be enabled in Profiler Global

Settings while installing or re-configuring Profiler.
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To match Eloqua contacts based on email addresses on a web page:

1. Navigate to a web page.

2. Click the Oracle Eloqua Sales Tools for Google Chrome icon.

3. Click the plus x emails found on this web page tab to expand it. A list of contacts matching the

email address(es) on the web page is displayed. You can filter your contacts. You can now

perform the following actions:

l Click individual contacts to view their Profiler digital body language.

l Click the Engage icon next to any contact. Engage opens in a separate tab where you can select (or

create) an email and modify the recipients.

l Click Send Email to All to send an email to all contacts on the list using Engage.

Matching to Oracle Eloqua contacts based on a domain

If you are investigating a company by visiting their website, Oracle Eloqua Sales Tools for

Google Chrome looks up the contacts at that domain (or company). These contacts are

found by comparing the domain of contact's email addresses in Eloqua with the domain

of the web page. This includes web pages with subdomains as well as nested pages.

-Example: If you navigate to www.oracle.com, Oracle Eloqua Sales Tools for

Google Chrome will display all the contacts in Eloqua with Oracle in their email

address.
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The number of contacts found is displayed in the badge on the extension icon. The badge

updates to show the contacts at the a web page for a new tab or window.

ëNote: In order to use this feature, Search must be enabled in Profiler Global

Settings while installing or re-configuring Profiler.

To match Eloqua contacts based on a domain:

1. Navigate to a web page.

2. Click the Oracle Eloqua Sales Tools for Google Chrome icon. A list of Eloqua contacts whose

email address matches the domain of the website is displayed. You can filter your contacts.

3. Click individual contacts to view their Profiler digital body language.
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Matching to contacts based on a LinkedIn profile page

When on a LinkedIn profile page, Oracle Eloqua Sales Tools for Google Chrome

performs a lookup for that contact inside Eloqua. The lookup is based on first name and

last name. The number of matching contacts is displayed in the badge on the extension

icon. If there is a single contact found, the Profiler digital body language is displayed. You

may also email the contacts by clicking the Engage icon.

If you navigate to any other LinkedIn page (other than a profile page), all contacts at the

domain LinkedIn are displayed.

ëNote: In order to use this feature, Search must be enabled in Profiler Global

Settings while installing or re-configuring Profiler.
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To match Eloqua contacts based on a LinkedIn profile page:

1. Navigate to a LinkedIn profile page.

2. Click the Sales Tools for Google Chrome icon.

l If a single contact is found (based on matching first name and last name), their Profiler digital body

language is displayed.

l If multiple contacts are found, they are listed. Select each contact to view their Profiler digital body

language.

l If there are no matching contacts, a contact not found message is displayed.

l You may also email the contact(s) by clicking the Engage icon.
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Oracle Eloqua Sales Tools for Microsoft
Outlook

Oracle Eloqua Sales Tools for Microsoft Outlook is an add-in for Microsoft Outlook. It

provides users with easy access to both Profiler and Engage straight through Microsoft

Outlook's email composer, and comes packaged with similar capabilities as the native

web and mobile versions of the (responsive) Profiler and Engage. This provides a

seamless and consistent experience for sales users that work across a range platforms

and devices. Sales users who leverage Microsoft Outlook as their primary tool to interact

with key prospects on a day-to-day basis have the ability to gain rich insight in cross-

channel buyer behavior, and access to marketing approved email templates without

having to leave their email platform of choice.

Oracle Eloqua Sales Tools for Microsoft Outlook is provided free of charge as an add-in

to all Engage customers. The use of Profiler is supported but optional for customers with

both Engage and Profiler licenses. Emails are sent through Microsoft Outlook, and are

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Profiler
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Engage
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created and visualized in Engage for sales users to review and track. An email activity is

created for each recipient.

Below is an overview of the features that can be accessed with the add-in:

Oracle Eloqua Profiler Oracle Eloqua Engage
Analyze Digital Body Language by drilling
into cross-channel buyer activities including
email open/clicks, form submission, web
activity and more.

Engage with Insight leveraging pre-
approved marketing templates or personal
emails without having to leave the Outlook
email composer.

Browse Lead Scores to identify the right
opportunity to chase for your buyers and
prospects.

Track Every Interaction by enabling
tracking on Outlook Emails, whether you’re
using a marketing template or writing a
more personal email.

Set-up Web Alerts and get notified once a
key prospects visits your website

Leverage Marketing Approved Content
by having access to email templates
straight within Microsoft Outlook.

Learn more by watching the video!

https://www.youtube.com/playlist?list=PLw7GyH-Hj8cNitnaj5hr1apDCn_wtt5f1
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Frequently asked questions

The following are some of the questions most often asked about Oracle Eloqua Sales

Tools for Microsoft Outlook.

Q. Are there any additional costs to use the Sales Tools for Microsoft Outlook add-in?

A. No, the Microsoft Outlook add-in will be provided free of charge for Oracle Eloqua

Engage customers.

Q. How do I install the Oracle Eloqua Sales Tools for Microsoft Outlook?

A. Engage users can install the add-in on their own. IT administrators can also install the

add-in for users in bulk. For information on mass deployment, contact My Oracle Support.

Q. What license do I need to access the Sales Tools for Microsoft Outlook add-in?

A. Sales users require, at a minimum, the Oracle Eloqua Engage and the Eloqua Sales

Tools for Microsoft Outlook licenses. To access Profiler from the Microsoft Outlook add-

in, sales users will also need the Profiler license.

Q. Are emails sent through Microsoft Exchange or Eloqua (Engage)?

A. Emails are sent through the customer's Exchange server. The add-in calls Eloqua to

create a deployment and provide the email content, that is then sent by the customer's

exchange sever. Emails are visualized in Engage for sales users to review and track. An

email activity is created for each recipient.

Q. What are the differences between Engage and the Sales Tools for Microsoft

Outlook add-in?

https://support.oracle.com/
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A. The two products have a very similar feature set, with a handful of key differences.

Functionality Engage Outlook
Tracked emails

Contact creation

Contact lookup

Preview an email prior to send

Field merges

Inserting additional field merges, not included in email templates

Access to templates

Support for protected templates created by marketing

Eloqua Profiler embedded / accessible

Plain text email

Contact validation:
      Unsubscribed

      Bouncebacks

      Master exclude

      Contact security

User able to save emails as templates / share with other users

Cloud content

Insertion of attachments from Eloqua

SSO

Localized

Restrict number of contacts per email send

User upload of images to Eloqua

Q. When I open Microsoft Outlook, a dialog message appears about using the "Send

Pictures With Document" setting. What does this mean?
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A Microsoft Outlook setting can be used to embed images in a message. This setting may

be on or off depending on your version of Microsoft Outlook and could be turned on or off

by you or your organization.

This setting may prevent adding the Oracle Eloqua tracking pixel when you send a

tracked email message.

You can continue to use the Microsoft Outlook add-in with this setting turned on. But we

recommend testing to ensure that tracking is not impacted by your particular Microsoft

Outlook version and configuration. If you want to turn off the setting, refer to this support

article from Microsoft.

Q. Is there a maximum number of recipients?

A. Yes, the maximum number of recipients that can be tracked is 100. Administrators

cannot manage this maximum for the Microsoft Outlook add-in.

Q. Is the hide in mobile feature supported in Sales Tools for Microsoft Outlook?

A. No. If a template is created in Eloqua that includes a hidden content, and a user sends

the template via Sales Tools for Microsoft Outlook, then that email does not hide the

content.

Q. Are locked blocks supported in Sales Tools for Microsoft Outlook?

A. Locked blocks are not supported in the Oracle Eloqua Sales Tools for the Microsoft

Outlook add-in. In the Microsoft Outlook add-in, sales users will be able to edit the locked

block styling.

Q. Is Microsoft Office 365 supported?

https://support.microsoft.com/en-us/topic/inline-images-may-display-as-a-red-x-in-outlook-704ae8b5-b9b6-d784-2bdf-ffd96050dfd6
https://support.microsoft.com/en-us/topic/inline-images-may-display-as-a-red-x-in-outlook-704ae8b5-b9b6-d784-2bdf-ffd96050dfd6
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=HideInMobile
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A. Microsoft Office 365 Professional Plus (ProPlus) is supported. This version of Office

365 still allows users to install the most recent version of Microsoft Outlook on their local

machines. View the Microsoft documentation for more information. Web-based versions

of Outlook that are a part of Office 365 are not supported.

Q. I see that you support Microsoft Office 365 for Exchange Server, does this mean

you support Office 365?

A. The Office 365 version of Exchange Server can be used to connect with Outlook 2019

and is therefore supported. The only version of the Office 365 product line that is

supported is Office 365 ProPlus.

Q. If emails are sent using my Exchange Server, how would bouncebacks be

tracked?

A. If a sales user sends an email to a contact using the add-in in Outlook, and that email

bounces, that bounceback is not currently tracked back to Eloqua.

Emails sent using Engage, which are sent through Eloqua, will track bouncebacks. This

is an important consideration when evaluating which application to use.

Q. Do emails sent through Microsoft Outlook appear in Engage?

A. Yes, emails sent from Microsoft Outlook that are tracked with the add-in will appear

inside the sent list in Engage.

Q. Is the add-in localized?

A. Yes, it is localized into the same languages that are supported by the Sales Tools

suite. See language support for a list of those languages.

https://docs.microsoft.com/en-us/deployoffice/about-office-365-proplus-in-the-enterprise
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/General/LanguageSupport.htm
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Q. How many tracked emails can users send at a time?

A. Users are limited to 100 tracked emails that can be sent at one time. Additionally, if you

configure the send limit in the Engage app, you can also limit the number of sales emails

that your reps can send to the same contact over a period of time.

Q. Why are locked sections in email templates not supported in Microsoft Outlook?

A. Microsoft Outlook does not support locked regions within an email. When users insert

an email template, all sections of the template will be editable. Customers should start to

audit their existing templates and plan accordingly.

Q. Is sign on with SSO supported?

A. Yes, after installing the add-in, users will login to the standard Eloqua login screen with

their credentials and can choose Sign in with SSO or another account.

Q. How can I avoid email opens when I view a sent message in Outlook?

A. The sent message includes a tracking pixel. Once the message is in the Sent folder,

Sales Tools for Microsoft Outlook removes its tracking pixel to avoid any artificial inflation

of metrics due to opening a message in your Sent folder. However, Microsoft Outlook

caches the first message in the Sent folder for approximately five minutes or until you

perform another action in Outlook such as opening a new Compose window.
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Installing Oracle Eloqua Sales Tools for
Microsoft Outlook

Oracle Eloqua Sales Tools for Microsoft Outlook is an add-in for Microsoft Outlook. It

provides users with easy access to both Profiler and Engage straight through Microsoft

Outlook's email composer, and comes packaged with similar capabilities as the native

web and mobile versions of the (responsive) Profiler and Engage.

ZImportant: Engage end users can install the add-in on their own. IT administrators

can also install the add-in for users in bulk. For information on mass deployment,

contact My Oracle Support.

Prerequisites

l You must have the Eloqua Engage and the Eloqua Sales Tools for Microsoft Outlook licenses.

To access Profiler from the Microsoft Outlook add-in, you must also have the Profiler license.

l Prior to installing Oracle Eloqua Sales Tools for Microsoft Outlook, ensure that your system

meets the following requirements:

Microsoft
Outlook

l Microsoft Outlook 2016

l Microsoft Outlook 2019

l Microsoft Outlook 2021

l Microsoft Outlook for Microsoft 365

Operating
system

l Microsoft Windows 10

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Profiler
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Engage
https://support.oracle.com/


©2025 Oracle Corporation. All rights reserved 241 of 269

l Microsoft Windows 11

Microsoft
Exchange
Server

l Microsoft Exchange Server 2016

l Microsoft Exchange Server 2019

l Microsoft Office 365

Mailbox
storage

l OST in Cached Exchange Mode (default mode)

l PST

Microsoft
.NET
Framework

v4.8+ must be installed on the computer where the add-in will be used. 4.8 is
installed by default with Windows 10.

Default
email
application
(Optional)

Users can open a compose window in Microsoft Outlook when clicking on a
contact's email address within Profiler. In order for a compose window to
open in Microsoft Outlook, users must configure Microsoft Outlook to be the
default email application on their machine.

You can search for and install new apps in the Oracle Cloud Marketplace

(https://cloudmarketplace.oracle.com/marketplace/en_US/homePage.jspx).

To install Oracle Eloqua Sales Tools for Microsoft Outlook:

1. Ensure Microsoft Outlook is not currently running on your machine. If it is open, you will be

prompted to close it before installing the add-in.

2. Follow one of the URLs below, depending on your Windows operating system:

Windows 32-bit:

https://cloudmarketplace.oracle.com/marketplace/app/SalesToolsMicrosoftOutlookWin32

Windows 64-bit:

https://cloudmarketplace.oracle.com/marketplace/app/SalesToolsMicrosoftOutlookWin64

3. Click Get App.

https://cloudmarketplace.oracle.com/marketplace/app/SalesToolsMicrosoftOutlookWin32
https://cloudmarketplace.oracle.com/marketplace/app/SalesToolsMicrosoftOutlookWin64
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4. Follow the instructions in the installation wizard, then click Finish.

5. Open Microsoft Outlook.

6. Sign in to Oracle Eloqua using your company name and credentials. If your company leverages

single sign-on, click Sign in with SSO or another account. For more details, see Signing in to

Eloqua.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/Administration/Tasks/SigningInToEloqua.htm
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/Administration/Tasks/SigningInToEloqua.htm
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ëNote: Signing in is required only for the first run of the Oracle Eloqua Sales Tools for
Microsoft Outlook add-in.

¤Tip: If you are using Microsoft Edge or Sales Tools for Microsoft Outlook to access the
Oracle Eloqua sign in page in an iframe, an addition should be made to trusted sites. Add

https://*.eloqua.com and the URL of the site where the login page (Oracle Eloqua

and/or Sales Tools) is being iframed. The browser must be closed fully and restarted

before the change is recognized. For additional information, see this Topliners post about

Oracle Eloqua login enhancements.

The Oracle Eloqua Sales Tools for Microsoft Outlook add-in is now installed and visible in

the ribbon.

https://community.oracle.com/docs/DOC-1020186
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Accessing Oracle Eloqua Sales Tools for
Microsoft Outlook

This topic outlines how to access the Oracle Eloqua Sales Tools for Microsoft Outlook

add-in once it has been installed.

Prerequisites

l Oracle Eloqua Sales Tools for Microsoft Outlook must be installed.

l You must have the Eloqua Engage and the Eloqua Sales Tools for Microsoft Outlook licenses.

To access Profiler from the Microsoft Outlook add-in, you must also have the Profiler license.

To access Oracle Eloqua Sales Tools for Microsoft Outlook:

1. Open Microsoft Outlook.

2. Click Options > Sign In from the main ribbon, or open an email and click Sign In.

3. Sign in to Oracle Eloqua using your company name and credentials. If your company leverages

Single Sign-On, click Sign in with SSO or another account.
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ëNote: Signing in is required only for the first run of the Oracle Eloqua Sales Tools for
Microsoft Outlook add-in.
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Sending a tracked email

Use Oracle Eloqua Sales Tools for Microsoft Outlook to send a tracked email directly

through Microsoft Outlook. Eloqua is called so that sent messages are created and

displayed in Engage's sent list for sales users to review and track. Email activity is

created for each recipient.

Prerequisites

l Oracle Eloqua Sales Tools for Microsoft Outlook must be installed.

l You must have the Eloqua Engage and the Eloqua Sales Tools for Microsoft Outlook licenses.

To access Profiler from the Microsoft Outlook add-in, you must also have the Profiler license.

ëNote: Tracking is enabled by default when the add-in is installed. Your

organization may desire tracking on all new emails to be off by default. For

example, you may want a sales representative to deliberately choose to track

specific emails and require them to check the tracking box. You can configure

whether this option is enabled by default or not via a Microsoft Windows Group

Policy or Microsoft System Center Configuration Manager (SCCM) deployment. For

more details, log in to My Oracle Support (https://support.oracle.com) and create a

service request.

To send a tracked email using Oracle Eloqua Sales Tools for Microsoft Outlook:

1. Open a new email in Microsoft Outlook. When tracking is enabled, the Tracking On box is

checked and Track Email option in the ribbon is selected. Users can toggle tracking on or off for

individual email messages. When the Tracking On box is cleared, the message is sent as a

https://support.oracle.com/
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personal email and is not tracked.

¤Tip: To automatically enable tracking for all new emails, in the main ribbon, navigate to

Options > Settings and check Always track new emails.

2. Add your recipients by manually entering email addresses or searching Oracle Eloqua

contacts.

ZImportant: The maximum number of recipients that can be tracked is 100.
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l The add-in automatically verifies if manually entered recipients are Oracle Eloqua contacts. If they are

not contacts, a Fix Validation Issues link is displayed. Click the link to add them as contacts before

sending the email. You can also remove the recipients if you do not want to add them as contacts.

l To search for Oracle Eloqua contacts, click Search Contacts in the ribbon.
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Search contacts by name, email address or title. Using Microsoft Outlook's standard contact search

(by clicking To... or Cc...) will not search Oracle Eloqua contacts. Click Add Contact to add them to

your recipient list. At least 3 characters must be specified to search.

ZImportant: Contact match and search is based on the contacts you have access to
based on your Oracle Eloqua user permissions.

3. Write a personal email or select an Oracle Eloqua template.

l To select a template, click Select Template in the email ribbon. You can search templates by its

name. At least three characters must be specified to search. Narrow the search by selecting specific

email groups. Sort templates by name, creation date, or modified date. Click Apply to use the selected

template in your email and override the current subject and body content (if any) of your email.

l Templates with cloud content cannot be used but they are still searchable. The Apply button will be

disabled when these templates are selected.
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l Microsoft Outlook does not support locked regions within an email. Once you select a template, all

sections will be editable.

l After a template is selected, the contacts are validated to check if they have the required field merges.

If not, you will be prompted to add the missing field merges before sending the email.

l You cannot use any files (pictures, documents, and so on) as Microsoft Outlook email attachments

because they are not accessible from the add-in. However, you can add attachments to the email

from your machine. These attachments are not tracked.

4. Click Preview Email. The preview allows you to take a peek at how the email will look like for

the first recipient in the list, including any field merges. In order to preview the email, the first

recipient must be validated and the subject cannot be empty. Close the preview and make any

necessary edits.

5. Click Send. Oracle Eloqua Sales Tools for Microsoft Outlook validates recipients to check for

any problems and will prompt you to fix any issues that are found.

6. After validation is complete, tracking parameters are added to the email. Click the Cancel

Sending link if you want to stop the email from being sent during this process. As an email is

sent to each contact, they are removed from the To line.
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Your email is sent to your recipients and appears in your Microsoft Outlook Sent Items

folder. It is automatically assigned a Tracked by Eloqua category. Email sent metrics are

also displayed. Learn about sent email metrics.

ZImportant: The sent message includes a tracking pixel. Once the message is in

the Sent folder, Sales Tools for Microsoft Outlook removes its tracking pixel to avoid

any artificial inflation of metrics due to opening a message in your Sent folder.

However, Microsoft Outlook caches the first message in the Sent folder for

approximately five minutes or until you perform another action in Outlook such as

opening a new Compose window.
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Creating new contacts using the Eloqua
Sales Tools add-in for Microsoft Outlook

As a sales user, you can use Oracle Eloqua Sales Tools for Microsoft Outlook to create

new Eloqua contacts for your leads.

Prerequisites

l Oracle Eloqua Sales Tools for Microsoft Outlook must be installed.

l You will need permission to manage contacts, which an administrator needs to enable for you.

An administrator is an Eloqua user who manages users and security groups.

To create a contact using Oracle Eloqua Sales Tools for Microsoft Outlook:

1. Open a new email in Microsoft Outlook, make sure the Tracking On box is checked, and type

your new contact's email address. You will see a Fix Validation Issues warning appear above

the To: field.

2. Click the Fix Validation Issues warning to open the Create New Contact window. This will allow

you to input additional contact details. The field selection is based on your selection in the View

drop-down menu.
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ëNote: You can use the View drop-down menu to change the selection of contact fields

available to you. Your selection will depend on what views your administrator sets up.

Administrators create and share contact views with sales rep using existing Eloqua

contact view management and access settings.

3. Click Add Contact when finished. Your tracked email to your new Eloqua contact is ready to be

sent! 
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Viewing email performance using Microsoft
Outlook

Once a tracked email is sent using Oracle Eloqua Sales Tools for Microsoft Outlook,

email metrics, such as opens and clicks, are collected. The metrics are available when

viewing the email in the Microsoft Outlook Sent Items folder. These metrics are also

available in Engage, and in Insight for marketing administrators.

To view sent email performance:

1. In Microsoft Outlook, open your sent email folder.

2. Search for the tracked email that you sent. Tracked emails have their own category.
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3. Open the email. The performance metrics are displayed in the message banner.

Report metrics

This report captures the following metrics.

Metric Description
Total Opens The number of times an email was opened. This includes

multiple opens by the original recipient or forwarded recipient.

Oracle Eloqua counts an email as opened if the recipient
loaded the tracking pixel image contained in the email or
clicked a link in the email. For more information, see
Calculating email opens.

Last Open The most recent date and time the email was opened.
Total Clicks The total clickthroughs. This includes multiple clicks by the

same recipient. System Action links are not tracked.

When reviewing metrics, note the following:

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=CalculatingEmailOpens
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l Open statistics are only captured if the email recipient has the display images setting enabled

for the email.

l When the email is forwarded or replied to, and the subsequent email is opened, the opens

count towards the total opens.

l The enable tracking feature does not impact the behavior of Microsoft Outlook.
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Validation issues

Validating recipients involves checking all email recipients against the Oracle Eloqua

contact database.

The validation process is always triggered automatically in the following cases:

l When a recipient is manually added to the recipient list

l When the contact lookup dialog is closed

l When an email is previewed

l When an email is sent

The validation process determines whether email recipients match certain conditions and

all validation issues must be fixed in order to send the tracked email:

l Are the recipients Oracle Eloqua contacts? To fix the issue, add recipients as contacts.

l Is all the information required for field merges in the selected template complete? To fix the

issue, add the missing contact information required for the field merges in the template.

l Can the email be sent to all contacts? For example, are contacts subscribed and do they have

valid email addresses? To fix the issue, remove any contacts who are excluded.

A green check mark displays after all validation issues have been resolved and the

tracked email can be sent.

After clicking send, additional validation occurs to ensure that send limits haven't been

exceeded. If they have, you will have to remove the contact.



©2025 Oracle Corporation. All rights reserved 259 of 269

Accessing Profiler

Oracle Eloqua Profiler can be accessed in Microsoft Outlook. With Profiler you are able to

view the contact details for a potential client, their activities, their lead score value, and so

on. Viewing a contact's information can help you decide what type of email to send to

them.

Prerequisites

l Oracle Eloqua Sales Tools for Microsoft Outlook must be installed.

l You must have the Eloqua Engage and the Eloqua Sales Tools for Microsoft Outlook licenses.

To access Profiler from the Microsoft Outlook add-in, you must also have the Profiler license.

To access Profiler in Oracle Eloqua Sales Tools for Microsoft Outlook:

1. Open Microsoft Outlook.

2. Open or select a message with the contact you want to view in Profiler.
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3. From the Oracle Eloqua ribbon, click Show Profiler.

Profiler automatically searches for all contacts in your recipient list. If there is only one

contact, their information is displayed. If you are launching Profiler from an email without

any recipients listed, the search contacts screen opens to help you quickly find the

contact you are looking for.
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Sales prioritization views

You can integrate with your CRM in a way that provides your sales team with a prioritized

lead list or contact calling list. Optionally, you can include links to Oracle Eloqua Engage

and Profiler.

Learn more about how to configure sales prioritization views in Salesforce.

Configuring sales prioritization views in Salesforce

This guide describes how you can create a lead or contact calling list for your sales team

in Salesforce, allowing them to prioritize by lead score and other criteria. Optionally, you

can include links to Oracle Eloqua Engage and Profiler.

Configuration prerequisites

l Salesforce administrator privileges

l CRM integration is set up in your Salesforce instance

l The Lead Score property from Eloqua has been synchronized to a property in Salesforce
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Configuration

The configuration requires the completion of the following high level steps:

1. Create the properties.

2. Create the view.

Creating the properties

This configuration involves creating new properties in Salesforce to show the Lead Score

Images. These images (typically composed of dollar sign and flame icons) appear inside

the Salesforce View and link users to Profiler and Engage. There will be a total of 16

images (A1, A2, A3, A4, B1, B2, B3, B4, C1, C2, C3, C4, D1, D2, D3, D4).

ëNote: The only required property is the Lead Score property, which is a

prerequisite for this configuration. The properties below are optional, but provide

visual cues and a better user experience.

To create the optional properties:

1. (Optional) Create the Lead Score Image property:

a. Create the 16 different lead score images or download the example images. For

example:

b. Upload the 16 images to Salesforce.

LeadScoringImages.zip
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i. Inside Salesforce, navigate to Documents.

ii. Click New to create a new document.

iii. Upload the image and then Save.

iv. Open the document and click View File. The image opens in a new tab.

v. Copy the URL from your browser address bar into a document or spreadsheet so

you can reference it later. Note: This is the URL to the image. You will need these

image URLs later.

vi. Repeat for each flame and dollar sign image.

c. Create a new field to lookup the appropriate image based off the lead score rating value.

In other words, if the lead score is A1, then we want Salesforce to display the A1 image.

i. Inside Salesforce, navigate to Setup > Leads > Fields.

ii. Create a New Custom Field.

iii. Step 1: Choose the Field Type. Select Formula.

iv. Step 2: Choose output type. Select Text

v. Step 3: Custom Field Definition Edit. Insert the following code, with your own data substituted

for the information highlighted below:

IMAGE(                                     

CASE( <API Name for Lead Scoring Field> ,

"A1", "<A1ImageURL>",

"A2", "<A2ImageURL>",

"A3", "<A3ImageURL>",

"A4", "<A4ImageURL>",

"B1", "<B1ImageURL>",

"B2", "<B2ImageURL>",
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"B3", "<B3ImageURL>",

"B4", "<B4ImageURL>",

"C1", "<C1ImageURL>",

"C2", "<C2ImageURL>",

"C3", "<C3ImageURL>",

"C4", "<C4ImageURL>",

"D1", "<D1ImageURL>",

"D2", "<D2ImageURL>",

"D3", "<D3ImageURL>",

"D4", "<D4ImageURL>",

"/s.gif"),

"Lead Rating")

vi. Step 4: Establish field-level Security. Select which profilers get access to this field.

vii. Step 5: Add to page layouts. Select the page layouts that this field will show up in

viii. Save

Here is an example:

ëNote: Your image URLs and Lead Scoring API name will differ from the example

shown above.
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2. (Optional) Create a property to link to Engage:

a. Create and store the Engage icon inside Salesforce.

i. Inside Salesforce, navigate to Documents.

ii. Create a New document.

iii. Upload the Engage icon and then Save.

iv. Open the document and click View File. The image opens in a new tab.

v. Copy the URL in the address bar. Note: This is the URL to the image. You will need the image

URLs later.

vi. Copy the URL from your browser address bar into a document or spreadsheet so you can

reference it later. Note: This is the URL to the image. You will need this image URL later.

b. Create a new field that displays the Engage icon, by performing the following steps:

ëNote: The icon will contain a hyperlink to Engage, with the lead's email address populated in
the To field. Alternatively, the URL could take the sales rep to a specific engage template.

i. Inside Salesforce, navigate to Setup > Leads > Fields.

ii. Create a New Custom Field.

iii. Step 1: Choose the Field Type. Select Formula.

iv. Step 2: Choose output type. Select Text

v. Step 3: Custom Field Definition Edit. Insert the following code, with your own data substituted for the

information highlighted below:

HYPERLINK("<Login URL>&Url=/apps/engage?sendTemplateEmailToContacts/" & Email, IMAGE

("<EngageIconURL>", " "))

ëNote: Specify the URL that you typically use to access (i.e. login to) Engage.

vi. Step 4: Establish field-level Security. Select which profilers get access to this field.
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vii. Step 5: Add to page layouts. Select the page layouts that this field will show up in.

viii. Save.

3. (Optional) Create a property to link to Profiler:

a. Create and store the Profiler icon inside Salesforce:

i. Inside Salesforce, navigate to Documents.

ii. Create a New Document.

iii. Upload the profiler image and then Save.

iv. Open the document and click View File.

The image opens in a new tab.

v. Copy the URL from your browser address bar into a document or spreadsheet so

you can reference it later. Note: This is the URL to the image. You will this image

URL later.

b. Create a new field which will show the Profiler icon with a hyperlink to the specific profiler

for that contact:

i. Inside Salesforce, navigate to Setup > Leads > Fields.

ii. Create a New Custom Field.

iii. Step 1: Choose the Field Type. Select Formula.

iv. Step 2: Choose output type. Select Text

v. Step 3: Custom Field Definition Edit. Insert the following code, with your own data

substituted for the information highlighted below:

HYPERLINK("<LoginURL>/apps/salesTools/profiler/contacts?emailAddress=" &

Email , IMAGE("<ProfilerImageURL>", " "))
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ëNote: Specify the URL that you typically use to access (i.e. login to)
Profiler.

vi. Step 4: Establish field-level Security. Select which profilers have access to this

field.

vii. Step 5: Add to page layouts. Select the page layouts that this field will show up in.

viii. Save.

Creating the View

This section is about creating a View on the Lead tab which will show a list of all the leads

sorted by the lead score.

1. Inside Salesforce, navigate to the Leads tab.

2. Click Create New View.

3. Specify a meaningful name for your new view.

4. Specify Filter Criteria - Filter the view.

Filter By Owner

The view can show all leads, my leads or leads in a specific queue. “My Converted Leads” will

show all the leads that are assigned to the user that is currently logged in. Only one view is

needed instead of creating a view for each user.

Filter by Additional Fields
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The lead score value occasionally can be empty or invalid. Therefore, by default, filter out the

following:

l Lead Score not equal to “”

l Lead Score not equal to “A”

In addition, filter out any custom property. For example: Region, Territory, State, and so on

5. Select Fields to Display – Add fields that will appear in the view.

Add the fields that will appear in the field, at a minimum add in Lead Score, and Name of the

contact. Make sure you add all of the optional fields that you created in the Creating Properties

section.

6. Save the view.

7. Sort on Lead Score by clicking the heading of the column inside the view.
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ëNote: You can configure the same view on the contacts tab by adding the same

properties to the Contact object and then creating the same view on the Contacts

tab.
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